)WH&SUDGOH

v14.3

How Monitor User Guide

ITPSWITCH



CHAPTER 1 WhatsUp Flow Monitor Overview

What is Flow Monitor?

How does Flow Monitor work?

System requirements

CHAPTER 2 Configuring WhatsUp Flow Monitor

Flow Monitor Sources

Determining which device sources to monitor

Configuring Flow sources

Configuring Cisco NetFlow Device Configuration

Creating flow sources

Deleting flow sources
About Flexible NetFlow

About Network Based Application Recognition (NBAR)

About CBQoS

Monitoring traffic on non-standard ports

Classifying traffic that is considered unclassified

Configuring data roll-up intervals

Managing users and user rights

Setting the logging level

Backing up and restoring the Flow Monitor databases

Using the database backup and restore backup utility for Flow Monitor

Stopping or restarting the collector

Using Flow Groups

CHAPTER 3 Navigating WhatsUp Flow Monitor

About the Flow Monitor Home page
About Flow Monitor database and service icons

Using the Flow Monitor Home page right-click menu

Searching reports for specific host names

11
12
14
15
19
20
24
25
26
30
31
32
32
33
34

35
39
39
41



CHAPTER 4 Using Flow Monitor reports

About the Flow Monitor Reports tab
About the Interface Details report

General view

Managing report views

Selecting an interface

Filtering data in a view

About the Interface Overview report
Filtering report data

About the Flow Monitor Log

Filtering report data

Exporting report data

About the Bandwidth Usage report

Selecting an interface

Filtering report data

About the Interface Usage report

About the NBAR and CBQoS Reports

Using Scheduled Reports: printing, exporting, and emailing reports

CHAPTER 5 Using Flow Monitor workspace reports

Understanding Flow Monitor workspace reports

Flow Monitor workspace report types

Navigating workspace reports

Using the workspace report menu

Using links in Flow Monitor workspace reports

Using zoom controls on line graphs

Using informational tooltips

Configuring workspace reports

Filtering Flow Monitor workspace reports in WhatsUp Gold

Exporting workspace report data
Configuring export settings

Linking to Flow Monitor reports from WhatsUp Gold workspace reports

44
45
47
47
48
49
54
55
56
58
59
59
61
61
63
65
67

70
71
73
73
73
74
75
76
78
79
80
81



WhatsUp Flow Monitor Overview

In This Chapter

What is Flow Monitor? 1
How does Flow Monitor work? 2
System requirements 2

What is Flow Monitor?

WhatsUp Gold Flow Monitor is a network traffic monitor that lets you gather, analyze and
report on network traffic patterns and bandwidth utilization in real-time.

WhatsUp Flow Monitor:

= Uses network protocols such as NetFlow, sFlow, Jflow and IPFIX to collect and analyze
information about the traffic on a router, switch, or other network device.

= Highlights overall utilization for the LAN or WAN, individual devices, or specific interfaces,
and provides information about the users, applications and protocols that consume
network resources.

=  Provides reports that allow you to:

= View network usage trends to determine when to upgrade hardware to increase network
capacity.

= Recognize and correct network configuration issues that may needlessly consume
network resources or expose your network to security vulnerabilities.

= Identify traffic which may indicate undesired network usage, such as unauthorized use of
peer-to-peer file sharing applications or a denial-of-service attack against your
organization.

= Troubleshoot and correct causes of spikes in network traffic before they become
problems.
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How does Flow Monitor work?

When a router or other device sends flow data to Flow Monitor, it follows the process shown
below.
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The router gathers information about the traffic that is passing through it and
summarizes that data into a NetFlow, sFlow, J-Flow (sampled NetFlow) or IP Flow
Information Export (IPFIX) export datagram.

2 The router sends the flow export to Flow Monitor, which acts as a flow collector.

LT? Note: sFlow data is sent every x number of packets (configurable on the sFlow device),
whereas all NetFlow data is collected and monitored. This means that sFlow data provides a
sampling of network traffic data, whereas NetFlow data provides all network traffic data.

3 The Flow Monitor collector stores the NetFlow, sFlow, J-Flow (sampled NetFlow) or IP
Flow Information Export (IPFIX) export in the database.

4 When the report data is viewed on the web interface, Flow Monitor retrieves the data
from the database and manipulates it to produce the report.

Y Tip: Flow Monitor can collect and generate reports for Flow data from multiple devices.

System requirements

WhatsUp Gold Flow Monitor has the same base system requirements
(http://www.whatsupgold.com/wug143relnotes) as WhatsUp Gold. In addition, WhatsUp
Gold Flow Monitor requires:

=  WhatsUp Gold Standard Edition, Premium Edition, MSP Edition, or Distributed Edition
= One or both of the following:

= At least one routing device that supports NetFlow version versions 1, 5, and 9, sFlow
versions 2 and 5, J-flow (sampled NetFlow) or IP Flow Information Export (IPFIX).

=  AFlow Publisher monitoring a flow source.


http://www.whatsupgold.com/wug143relnotes
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= 32-bit MS SQL Server 2005 Standard Enterprise Edition, 32-bit or 64-bit Microsoft SQL
Server 2008 Standard or Enterprise Edition, or 32-bit or 64-bit Microsoft SQL Server Cluster
2005, 2008, or 2008 R2 (all editions except Microsoft SQL Server Express edition)

W Note: WhatsUp Gold Flow Monitor is more demanding on the database than WhatsUp Gold.
While WhatsUp Gold Flow Monitor can successfully use SQL Server 2005 Express, we
recommend either 32-bit MS SQL Server 2005 Standard or Enterprise Edition or 32-bit or 64-
bit Microsoft SQL Server 2008 Standard or Enterprise Edition for best performance.

= 2 GHz dual-core processor (required) to quad-core processor (recommended)
= An additional 2 (required) to 4 GB RAM (recommended)
= 16 GB (required) to 22 GB (recommended) hard disk space for the databases

W Note: If using Microsoft SQL Server 2005 or Microsoft SQL Server 2008, the database size is
limited by available hard disk space.
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Flow Monitor Sources

Flow Sources

Flow Monitor acts as a flow collector and analyzer, providing a central location for the
collection, summarization, storage and analysis of network traffic data. This network traffic
data is captured as flow data, and is provided by network monitoring protocols implemented
on network devices throughout the network.
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Flow sources use one of the following supported network monitoring protocols to send flow
data to Flow Monitor.

NetFlow. A network protocol developed by Cisco Systems and later adopted as an IETF
informational standard for collecting IP traffic information. Flow Monitor supports
NetFlow versions 1, 5, and 9 as well as Flexible NetFlow, which is based on NetFlow v9.
Flexible NetFlow is often used to support Cisco's Network Based Application Recognition
(NBAR) technology.

sFlow. A network monitoring technology that provides IP traffic information using packet
sampling. Flow Monitor supports sFlow versions 2 and 5.

JFlow. A network protocol developed by Juniper to run on the JUNOSe for collecting IP
traffic flow statistics.

IPFIX. An IETF informational standard developed to create a non-proprietary network
protocol that is compatible with NetFlow.

A network flow is a unidirectional sequence of packets that have the following characteristics
in common:

Source IP address and port number
Destination IP address and port number
IP Protocol

Ingress interface

IP Type of Service (ToS)

Flow sources that utilize these network protocols provide detailed data about individual
flows to Flow Monitor using flow records. Examples of the types of information that can be
contained in a flow record are:

Version numbers

Sequence numbers

Input and output interface indices

Timestamps for the flow start and finish time, in milliseconds since the last boot.
Number of bytes and packets observed in the flow

Layer 3 headers including:

Source & destination IP addresses

Source and destination port numbers

IP protocol

Type of Service (ToS) value

The union of all TCP flags observed over the life of the flow (TCP flows).
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= Layer 3 Routing information, including:
= [P address of the immediate next-hop along the route to the destination

= Source and destination IP masks (prefix lengths in CIDR notation)

SNMP Polling

While Flow Monitor normally receives flow data from a flow source, it can also poll a source
using SNMP to gather data from a network device. Flow Monitor can actively poll a source for
the following data:

= Total interface traffic. Provides summary data forincoming and outgoing interface
traffic.

= NBAR information. Provides summary data for each application identified using Cisco
Systems Network Based Application Recognition (NBAR) technology.

= CBQoS information. Provides summary data for each class in the Quality of Service class
map for the interface.

Determining which device sources to monitor

The information that Flow Monitor collects is influenced by the location of the flow sources
relative to firewalls or other devices that perform network address translation (NAT). In short,
the data is dependent on what and how the source sees. Carefully consider which routers or
other Flow-enabled devices you want to configure to export flows to Flow Monitor to ensure
that you see the type of data that you want to see.

Depending on where the source is located relative to the device performing NAT, traffic to
and from internal (private) IP address are reported differently in the exported NetFlow data.

= [f the source is inside the firewall, or if no firewall exists, the exported flow data includes
the internal IP address for devices generating and receiving traffic. This allows you to
pinpoint the exact device to which the traffic belongs.

= [f the source is outside the firewall, the exported flow data aggregates all traffic to and
from internal devices and report it as belonging to the public address of the device
performing NAT. In this case, you can only determine that an internal device originated or
received traffic, but you cannot pinpoint the traffic as belonging to a specific internal
device.

= When the device exporting flows is also performing NAT, you can configure the device to
export the flow data using either the private or the public NAT address, mimicking either
of the above scenarios. To see internal IP addresses, configure the device to export data
on ingress and egress for the internal interface. To see all traffic reported using the
external IP address of the NAT device, configure the device to export data on ingress
and egress for external interfaces. For more information, see Configuring NetFlow
sources (on page 7).
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Other conditions may also change the nature of the data reported by Flow Monitor.

= [f NAT occurs anywhere in the path between the source and the destination, IP addresses
reported are altered to include the address of the NAT. In most cases, this does not
present a problem, but it may require monitoring multiple flow sources to track traffic in
complex network environments.

= Virtual private networks and other tunneling technology (such as ESP or SSH) can appear
to distort reports. In these cases, Flow Monitor reports large amounts of traffic sent over a
small number of flows. This is expected behavior, as VPNs and other tunnels aggregate
traffic from multiple connections and funnel it through a single connection.

Configuring Flow sources

Before you can view meaningful reports, you must configure Flow Monitor and Flow-enabled
devices, such as routers or switches, to communicate network activity back to the Flow
Monitor listener application.

Configuring Flow sources is a three-part process that requires:

1 Setting up Flow Monitor to listen for Flow data on the appropriate port.
2 Configuring Flow devices to send Flow data to Flow Monitor.
3 Setting options for the Flow source in Flow Monitor.

To configure Flow Monitor to listen for NetFlow data:

LT Note: By default, Flow Monitor listens for Flow data on port 9999. If you want to use that
port, you do not need to perform this procedure.

1 From any workspace view or report in the web interface, select GO. The GO menu
appears.

2 If the Flow Monitor section is not visible, click Flow Monitor. The Flow section of the GO
menu appears.

3 Select Configure > Flow Settings. The Flow Settings dialog appears.

4 In Listener port, enter the port number over which Flow Monitor should listen for Flow
data.

5 Click OK to save changes.



Using WhatsUp Gold Flow Monitor

To configure Flow devices to send Flow data to Flow Monitor:

a5 Caution: This procedure is an example that applies to a Cisco 1812 router and should not be
used for other devices. The process for configuring a device to export Flow data varies widely
from device to device and dependent upon your network configuration. Please see your
router's documentation to determine the correct process for your device.

= Step 1. Open the configuration interface for the router and enter the commands detailed
in the following table to configure global options for all interfaces on the router.

Command

Purpose

enable

Enters privileged EXEC mode. Enter your password if
prompted.

configure terminal

Enters configuration mode.

ip flow-export version
<version number>

Sets the version of the NetFlow protocol that should be
used to export data. Flow Monitor supports versions 1, 5,
and 9 only.

ip flow-export
destination <IP> <port>

Enables the router to export Flow data. Substitute the
Flow Monitor server's IP address for <IP> and the listener
port specified in the Flow Monitor Flow Settings dialog
for <port>.
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= Step 2. Enter the commands detailed in the following table to enable the router to export
Flow data about the traffic on an interface. You must repeat these commands for each

interface.

Command Purpose

interface <interface> Enters the configuration mode for the interface you
specify. Substitute <interface> with the interface's name
on the router.

ip flow ingress Enables Flow data export. Select the command that best
fits your needs.

- Or -
= ip flow ingress exportsflows of all inbound

ip flow egress traffic that uses the interface.
= ip flow egress exportsflows of all outbound

traffic that uses the interface.

Y Tip: If the device exporting Flow data is also performing network address translation (NAT),
we recommend exporting egress data from the internal interface so that private network
addresses are communicated. Any other configuration results in all private addresses
reporting as the public addresses of the device performing the network address translation.

W Note: Other options exist for configuring NetFlow. For a complete list of available options,
see Configuring NetFlow (http://www.whatsupgold.com/NF_CiscoCfg) on the Cisco Web site.

To configure options for Flow sources in Flow Monitor:

1 From any workspace view or report in the web interface, select GO. The GO menu
appears.

2 If the Flow Monitor section is not visible, click Flow Monitor. The Flow section of the GO
menu appears.

3 Select Configure > Flow Sources. The Flow Sources dialog appears.
4 Select the source from the list, then select Edit. The Flow Source dialog appears.

LT? Note: If you cannot locate a source in the list, verify that the source device is set up to export
Flow data properly. All devices sending Flow data to Flow Monitor automatically appear in
the list.

5 In Display Name, enter a friendly name for this Flow source. This name is used
throughout Flow Monitor to identify this source.

6 Verify that Collect data from this source is selected.


http://www.whatsupgold.com/NF_CiscoCfg
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7 Set SNMP options. Flow Monitor uses SNMP to query information about the interfaces
on the NetFlow source.

a) Select the appropriate SNMP credentials. If the credentials you want to use are not
included in the list, click the browse button (...) to open the Credentials Library. For
more information on configuring credentials, see Using Credentials in the WhatsUp
Gold User Guide.

b) To set advanced options, such as timeout and number of retries, click Advanced. The
Advanced dialog appears. Set the appropriate values, then click OK to return to the
Flow Sources dialog.

c) Select Query to query the router using SNMP to get updated names and speeds for
the available interfaces.
8 Configure the speed of each interface, which is used to calculate capacity as a
percentage of the total interface speed.
a) Select an interface, then click Edit. The Flow Interface dialog appears.

b) Select Hide this interface from the Flow Monitor Home page and related
configuration properties to hide the selected interface from the Flow Monitor Home
page and other menu options in Flow Monitor. This lets you display only the
interfaces that are relevant to your bandwidth monitoring requirements.

LGF Note: Null(0) interface names are hidden by default because they are not a true source
interface. Null(0) interfaces show traffic that a router has dropped or traffic that a router has
generated. In both cases the ifindex = 0 and as a default convention we name an interface =
Null because the interface is none existent. If you want Null(0) interface information to
display as a source interface, make sure that you uncheck the Hide this interface from the
Flow Monitor Home page and related configuration properties option.

c) Select Specify a custom speed for this interface. The In and Out fields are enabled.

d) InInand Out, enter the upper limit of the interface in bps (bits per second). Common
interface speeds expressed in bps are:

= 1 Gbps = 1,000,000,000 bps
= 100 Mbps = 100,000,000 bps
= 10 Mbps = 10,000,000 bps

After you configure the listener port and set up Flow Monitor sources, Flow Monitor begins
tracking data and generating reports.

10
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Configuring Cisco NetFlow Device Configuration
The Cisco NetFlow Device Configuration dialog provides Flow Monitor with the ability to

configure a Cisco device to send flow records to Flow Monitor.

Use this dialog to:

= Enter connection information and credentials used to connect to the Cisco device.
= Set the NetFlow version to be used by the flow exporter.

= Set the active and inactive timeouts used for cache management.

= Select the interfaces from which you want the device to collect and send flow data.

= Configure the NetFlow collectors, which in most cases includes Flow Monitor.

Enter the connection information and credentials to connect and authenticate with the Cisco
network device.

= Source IP address. Enter the IP address of the Cisco NetFlow enabled device from which
you want to collect NetFlow statistics.

= SNMP credentials. Select or create the SNMP credentials to use to connect to the Cisco
NetFlow enabled device. Click the browse (...) button to add, edit or delete SNMP
credentials. Click the Advanced button to set SNMP timeout and retry parameters.

=4 Tip: When you have selected valid SNMP credentials, the dialog queries the device and
populates the NetFlow configuration parameters as well as the interface list. Use the Query
button to update this information from the Cisco device.

Enter the NetFlow configuration parameters to set the NetFlow version and configure the
NetFlow cache on the Cisco device.

= NetFlow version. Enter the NetFlow version you want the exporter to deliver the flow
records.

= Active timeout. Enter the Active timeout for flow records in the NetFlow cache. This
value determines how long active, long-lived flows are kept in the NetFlow cache before
sending to the collector. (Range: 1-60 minutes) (Default: 2 minutes)

= Inactive timeout. Enter the Inactive timeout value for flow records in the NetFlow cache.
This value is used to ensure that completed or inactive flows are not kept in the NetFlow
cache indefinitely. (Range 10 - 600 seconds) (Default: 30 seconds)

11
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The Interface list displays the interfaces that can provide NetFlow data.

= Name. Displays the interface name as configured on the Cisco network device.

= Ingress. Select this option if you want to collect flow statistics on incoming traffic on this
interface.

= Egress. Select this option if you want to collect flow statistics on outgoing traffic on this
interface.

W Note: If you have selected to collect flow statistics from both Ingress and Egress traffic on a
single interface, we recommend that you do not select to collect flow statistics from any
other interface, otherwise traffic may be duplicated as traffic that is internally routed will
appear on two interfaces within the device.

Enter the IP address and port number for the devices collecting Flow Monitor traffic.

= |P address. Enter the IP address of the collector.

= Port. Enter the Port number on which the collector is listening for flow data. (Default port
for Flow Monitor: 9999)

Click Update to save the settings.

Creating flow sources

Under normal circumstances, a flow source is automatically added by configuring the device
to send flow data to the Flow Monitor listener. When the flow information arrives, Flow
Monitor creates the source and displays this information in the Flow Monitor Home and Flow
Sources list. When detailed flow data is not needed or is unavailable for a particular source,
you can manually create a flow source and configure it to use SNMP to collect the following
types of data:

= Total counts for incoming and outgoing interface data.

= (CBQoS information.

= Total counts for NBAR data.

To create a flow source:

1 Navigate to the Flow Source creation dialog.
a) From the WhatsUp Gold web interface, select GO. The GO menu appears.
b) Click the Flow Monitor icon. The Flow Monitor Menu appears.

c) On the Flow Monitor menu, select Configure > Sources. The Flow Sources list
appears.

d) Click Create. The Flow Source creation dialog appears.

12
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2

3

&

Identify and enable the flow source.

a) Inthe Source IP Address box, type the IP address of the device you want to make a
Flow Monitor source.

b) Inthe Display Name box, type the name you want to use to identify the flow source.

c¢) Select Enable data collection from this source.
Set SNMP options.

Note: Flow Monitor uses SNMP to query information about the interfaces on the source.

a) Select the appropriate SNMP credentials. If the credentials you want to use are not
included in the list, click the browse button (...) to open the Credentials Library. For
more information on configuring credentials, see Using Credentials in the WhatsUp
Gold User Guide.

b) To set advanced options, such as timeout and number of retries, click Advanced. The
Advanced dialog appears. Set the appropriate values, then click OK to return to the
Flow Sources dialog.

c) Select Query to query the router using SNMP to get updated names and speeds for
available interfaces.
Select the data you want to gather using SNMP polling.

To collect total interface data, select Poll source for total interface traffic.
To collect NBAR information, select Poll source for NBAR information.

To collect CBQoS information, select Poll source for CBQoS information.

Configure the speed of each interface, which is used to calculate capacity as a
percentage of the total interface speed.

a) Select an interface, then click Edit. The Flow Interface dialog appears.

b) Select Hide this interface from the Flow Monitor Home page and related
configuration properties to hide the selected interface from the Flow Monitor Home
page and other menu options in Flow Monitor. This lets you display only the
interfaces that are relevant to your bandwidth monitoring requirements.

Note: Null(0) interface names are hidden by default because they are not a true source
interface. Null(0) interfaces show traffic that a router has dropped or traffic that a router has
generated. In both cases the ifindex = 0 and as a default convention we name an interface =
Null because the interface is none existent. If you want Null(0) interface information to
display as a source interface, make sure that you uncheck the Hide this interface from the
Flow Monitor Home page and related configuration properties option.

c) Select Specify a custom speed for this interface. The In and Out fields are enabled.

13
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d) InInand Out, enter the upper limit of the interface in bps (bits per second). Common
interface speeds expressed in bps are:

= 1 Gbps = 1,000,000,000 bps
= 100 Mbps = 100,000,000 bps
= 10 Mbps = 10,000,000 bps

Deleting flow sources

When you no longer want to gather flow data from a source, it can be deleted. When you
delete a flow source, both the configuration information and all flow data associated with the
source is deleted. The following procedure describes how to delete a flow source.

To delete a flow source:

1

Navigate to the Flow Sources list dialog.
a) From the WhatsUp Gold web interface, select GO. The GO menu appears.
b) Click the Flow Monitor icon. The Flow Monitor Menu appears.

¢) On the Flow Monitor menu select Configure > Sources. The Flow Sources list
appears.

Disable the source.

a) On the Flow Sources list, select the source you want to delete.
b) Click Edit. The Flow Source edit dialog appears.

c) Clear Enable flow data collection from this source option.

d) Click OK. The Flow Sources list appears.
Delete the source.

a) Verify that the source you wish to delete is not enabled. The word No appears in the
Enabled column when the source is not enabled.

b) Click Delete. A delete verification dialog appears.

c) Click Yes to verify that you want to delete the source. The Flow Sources list dialog
appears with the source deleted.

14
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About Flexible NetFlow

Cisco I0S Flexible Netflow provides the next level of flexibility and scalability in monitoring
network traffic, bringing a new understanding to who is using the network, what applications
they are employing, when they are using the applications, and where the traffic originated.

Flexible NetFlow Components

Flexible Netflow is implemented using flow monitors, the following is a description of flow
monitors.

Flow monitors. Flow monitors are applied to interfaces to perform network traffic
monitoring. These flow monitors consist of the following components:

Flow records. A record is a combination of key fields, which are used to uniquely define a
flow, and nonkey fields, which provide additional information about a flow, but are not
used to define the flow. In Flexible NetFlow, both key and nonkey fields can be defined in
the record definition, which allows for customized data collection.

Flow cache. Collects IP data flow records in a router or switch, analyzes this data and
prepares the data for export. Flexible Netflow has the capability to track and monitor
multiple NetFlow caches, each configured to monitor specific information.

NetFlow exporter. Exports the data in the flow monitor cache to a remote system, such
as Flow Monitor, for analysis and storage. You can create more than one flow exporter,
each assigned to one or more NetFlow collectors.

NetFlow collector. An application that utilizes exported data from one or more NetFlow
enabled routers or switches, aggregates and filters the data, then performs real-time
visualization and analysis of the recorded and aggregated flow data. Flow Monitor is an
example of a NetFlow collector.

15
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Flexible NetFlow records

Flexible NetFlow can track packet information from Layer 3, as well as some Layer 2
information. The Flexible NetFlow record can be customized to monitor data based on your
specific monitoring needs. The information available includes:

= Source and Destination MAC addresses

= Source and Destination IP addresses

= Type of Service

= Differentiated Services Code Point (DSCP)
= Packet and byte counts

= Flow timestamps

= |nput and output interface numbers

= TCPflags

= Routing information

Where traditional NetFlow provided a strict definition of which fields in a record are key field,
used to define a flow, Flexible NetFlow allows you to define a flow based on the fields and
data you want to monitor, which allows for the ability to export only the data needed by the
collector to conduct its analysis and reporting. Additionally, there is more data available in
Flexible NetFlow than in traditional NetFlow which allows for extensive customization and
flexibility in defining flow records.

Flexible NetFlow and Network Based Application Recognition
(NBAR)

Through this definition of flows, it is possible to gather information that can be used by Cisco
Network Based Application Recognition (NBAR) to identify application data within a flow and
provide flow statistics on the application traffic.

Configuring Flexible NetFlow on a Cisco device

Flexible NetFlow can be used to support the implementation of Cisco Network Based
Application Recognition (NBAR) technology.

To configure a network device to utilize Flexible NetFlow, perform the following tasks:

= Create a flow monitor.
= Define the flow record.

= (Create a flow exporter.

These tasks are described in the following sections, using an example configuration to
illustrate how to complete the tasks from the Cisco I0S command line interface (CLI).

16
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m Note: The network device you want to configure must be running a Cisco 10S release that
supports Cisco I0S Flexible NetFlow.

Creating a flow monitor

The following example illustrates how to configure a Flexible NetFlow enabled device to
utilize Flexible NetFlow in support of NBAR and Flow Monitor application monitoring. For
more information see the Cisco IOS Flexible NetFlow configuration guide
(http://www.cisco.com/en/US/docs/ios/fnetflow/configuration/guide/get_start_cfg_fnflow.h
tml#wp1056535).

To create a flow monitor:
1 Enter the privileged EXEC mode, and then enter the global configuration mode.
Router> enable
Router# configure terminal
2 Create a flow monitor, and enter the flow monitor configuration mode.
Router (config) # flow monitor application-mon
Router (config-flow-monitor) # description app traffic analysis

Router (config-flow-monitor) # cache timeout active 60

Defining a flow record
To define a flow record:
1 Enter the privileged EXEC mode, and then enter the global configuration mode.
Router > enable
Router# configure terminal
2 Enter the flow monitor configuration mode.
Router (config) # flow monitor application-mon
3 Name the record and enter a description.
Router (config-flow-monitor) # flow record nbar-appmon

Router (config-flow-record) # description NBAR Flow Monitor

17
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4

Define key fields, using the match keyword.

Router (config-flow-record) # match ipv4 tos

Router (config-flow-record) # match ipv4 protocol

Router (config-flow-record) # match ipv4 source address

Router (config-flow-record) # match ipv4 destination address
Router (config-flow-record) # match transport source-port
Router (config-flow-record) # match transport destination-port
Router (config-flow-record) # match interface input

Router (config-flow-record) # match interface output

Router (config-flow-record) # match application name

Define nonkey fields, using the collect keyword.

Router (config-flow-record) # collect datalink mac source address input

Router (config-flow-record) # collect datalink mac destination address
input

Router (config-flow-record) # collect routing destination as

Router (config-flow-record) # collect routing next-hop address ipv4
Router (config-flow-record) # collect ipv4 dscp

Router (config-flow-record)# collect ipv4 id

Router (config-flow-record) # collect ipv4 source prefix

Router (config-flow-record) # collect ipv4 source mask

Enter the flow monitor configuration mode and configure the flow monitor to use the
newly configured record.

Router (config) # flow monitor application-mon

Router (config-flow-monitor) # record nbar-appmon

Creating a flow exporter

When the record is complete, you can create the flow exporter. This component exports
records from the flow monitor on the network device to the flow collector, in this case Flow
Monitor.

To create a flow exporter:

1

2

Enter the privileged EXEC mode, then enter the global configuration mode.
Router > enable

Router# configure terminal
Create and describe the flow exporter.
Router (config) # flow exporter export-to-ipswitch-flow-monitor

Router (config-flow-exporter) # description Flexible NF v9

18
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3 Set the destination flow collector IP address.
Router (config-flow-exporter) # destination 192.168.3.47
4 Define the source interface.
Router (config-flow-exporter) # source GigabitEthernet0/0
5 Define the PDU type and destination port.
Router (config-flow-exporter) # transport udp 9996
6 Set options for exporter operation.
Router (config-flow-exporter) # template data timeout 120
Router (config-flow-exporter) # option interface-table
Router (config-flow-exporter) # option exporter-stats timeout 120
Router (config-flow-exporter) # option application-table timeout 120

7 Enter the global configuration mode and configure the flow monitor to use the new
flow exporter.

Router# configure terminal

Router (config) # exporter export-to-ipswitch flow monitor

About Network Based Application Recognition (NBAR)

Network Based Application Recognition (NBAR) is an application classification engine used to
recognize a wide variety of applications. It can detect both Web-based and client-server
applications.

NBAR identifies applications and protocols in Layer 4 to layer 7 using the following
information:

= Static TCP and UDP port numbers

=  Non UDP or TCP IP protocols

= Dynamically assigned TCP and UDP port numbers
= Sub-port classification

= Deep packet inspection

Protocol Discovery is a NBAR feature that collects application and protocol statistics for each
interface based on the results of the application identification. Flow Monitor collects these
statistics from the interface using Simple Network Management Protocol (SNMP) to poll the
NBAR PD Management Information Base (MIB) where these statistics are stored.

The Protocol Discovery feature captures key statistics associated with each protocolin a

network. These statistics can be used to define traffic classes and QoS policies for each traffic
class.
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Configuring NBAR on a Cisco device

You must enable NBAR for each interface from which you want to collect application
statistics. The following example describes how to enable NBAR on an interface.

To enable NBAR on an interface:

1 Enter the privileged EXEC mode, then the global configuration mode.
Router> enable
Router# configure terminal

2 Enable Cisco Express Forwarding (cef).
Router (config) # ip cef

3 Enter the interface configuration mode for the interface on which you want to enable
NBAR.
Router (config) # interface FastEthernet 0/1

4 Initiate NBAR protocol discovery on the interface.
Router (config-if) # ip nbar protocol-discovery

5 Exit the interface configuration mode.
Router (config-if) # exit

About CBQoS

Class-based quality of service (CBQoS) is the ability of a network to provide improved services
to identified classes of network traffic. These services include supporting dedicated
bandwidth, improving loss characteristics, managing network congestion, traffic shaping and
setting traffic priorities. CBQoS involves two major components, traffic classes, and traffic
policies.

Traffic classes

In the classification of network traffic, a traffic descriptor categorizes a packet as belonging to
a group or class. By classifying network traffic, you can divide it into multiple priority levels or
classes of service. Traffic classes are created using the class-map command which maps
protocols and applications to a particular class.

Traffic policies

A traffic policy provides the mapping between the classes and the network controls used to
provide the traffic priority, bandwidth guarantee, traffic shaping and other services available
to traffic classes. Traffic policies are created using the policy-map command and are
assigned to a particular interface using the service-policy command.
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Configuring CBQoS on a Cisco device

To configure class-based QoS (CBQoS) on a Cisco device, perform the following tasks:

= (Create the traffic classes using the class-map command
= (reate the traffic policy using the policy-map command

= Attach the traffic policy to an interface using the service-policy command.

W Note: The following procedures illustrate how to create a traffic class, how to create a traffic
policy and how to attach the policy to an interface. The specific commands used to illustrate
how these steps may be accomplished on a Cisco router are only for the purposes of this
example. For more detailed information on how to implement QoS for your network, see
Creating a Traffic Policy in the Cisco I0OS Quality of Service Solutions Configuration Guide
(http://www.cisco.com/en/US/docs/ios/12_2/qos/configuration/guide/fqos_c.html).

To create a traffic class:

1 Enable the privileged EXEC mode and enter the global configuration mode.
Router> enable
Router# configure terminal

2 Create the class name and enter the configure class map mode.

Router (config) # class-map match-any NMclass

m Note: The match-any keyword is used when all of the match criteria in the traffic class must
be met in order for a packet to be placed in the specified traffic class.

3 Use one or more match commands to specify the match criteria. Packets that match the
specified match criteria will be placed in the traffic class.

Router (config-cmap) # match protocol snmp

Router (config-cmap) # match protocol icmp

LT Note: You can repeat the steps that create a class name and specify the match criteria to
create as many classes as are needed to define the policy you want to apply to the interface.

4 Exit the class map configuration mode.

Router (config-cmap) # exit
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Example: Class Map configuration

The following is an example of a class map configuration.

class-map match-any nm
match protocol snmp
match protocol icmp
class—-map match-any p2p
match protocol kazaa?2
match protocol gnutella
match protocol edonkey
match protocol bittorrent
match protocol fasttrack
match protocol directconnect
match protocol winmx
class—-map match-all FTP
match protocol ftp
class—-map match-any web
match protocol http
class—-map match-any utube

match protocol http s-header-field "*http://www.youtube.com/*"

To create a traffic policy:

1

Enable the privileged EXEC mode and enter the global configuration mode (config).
Router> enable

Router# configure terminal
Create the traffic policy and enter the policy-map configuration mode (config-pmap).

Router (config) # policy-map newPolicy

Specify the name of the class to associate with the policy and enter the policy-map class
configuration mode (config-pmap-c).

Note: In the policy-map class configuration mode you can define one or more QoS features
which supply services supporting dedicated bandwidth, improving loss characteristics,
managing network congestion, traffic shaping and setting traffic priorities. For more
information see Creating a Traffic Policy in the Cisco /OS Quality of Service Solutions
Configuration Guide
(http://www.cisco.com/en/US/docs/ios/12_2/qos/configuration/guide/fqos_c.html).

Router (config-pmap) # class NMclass
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4 In the policy-map class configuration mode define the QoS features you want to apply
to the class.

Router (config-pmap-c) # drop

W Note: You can repeat the steps associating a class with the policy and defining the QoS
features to apply to the class as many times as is necessary to create a policy that establishes
services for all of the defined classes.

5 Exit the policy-map class configuration mode.
Router (config-pmap-c) # exit
Example: Traffic policy

The following is an example of a tr

policy-map crTest2

class p2p

drop
class FTP

drop
class nm

set dscp af43
class web

set dscp afl2
class utube

set dscp af43

To associate a policy with an interface:
1 Enable the privileged EXEC mode and enter the global configuration mode (config).
Router> enable
Router# configure terminal
2 Select the interface to configure and enter the interface configuration mode.
Router (config) # interface GigabitEthernet0/0
3 Attach the policy map to the interface.
Router (config-if) # service-policy output input newPolicy
4 Exit the interface configuration mode.

Router (config-if) # exit

LT Note: For more information on associating a policy with an interface, see Attaching a Traffic
policy to an Interface in the Cisco IOS Quality of Service Solutions Configuration Guide
(http://www.cisco.com/en/US/docs/ios/12_2/qos/configuration/guide/fqos_c.html).
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Monitoring traffic on non-standard ports

Flow Monitor automatically classifies traffic for most common applications. However, in some
cases, you may need to create a custom definition to ensure that Flow Monitor properly
classifies some traffic. This need is most common when:

Your device routes traffic for applications that use a proprietary protocol. This may be a
custom program that uses a protocol developed in-house to send data across the
network or a third-party application that uses its own custom protocol to transmit data.

Your device routes traffic for standard applications over non-standard ports. Examples
include a standard Web server running on a port other than 80 or an FTP client
connecting to an FTP server that runs on a port other than 21.

T Note: In Flow Monitor, for traffic to be considered "unclassified," both the port from which

the data is sent, and the receiving port must not be classified in the Flow Ports dialog. If
either the sending or receiving port is classified, the traffic is associated with the application
of the classified port.

To accommodate these cases, you can classify traffic that meets specific rules so that Flow
Monitor reports that traffic as belonging to a certain application.

@ Important: You can configure the amount of time unclassified traffic data is kept. For more

information, see Configuring data roll-up intervals (on page 26).

Tip: If Flow Monitor detects a large amount of traffic to an unmonitored port, the Top
Applications workspace report displays a yellow warning flag that explains the situation and
guides you in defining the unmonitored port. This can help you to proactively detect
emerging non-standard traffic on your network. You can also use the Unclassified Traffic
dialog (available from any page in Flow Monitor by selecting GO > Configure > Flow
Unclassified Traffic) to view all unclassified traffic since the last hourly rollup.

To define rules for classifying traffic that uses non-standard ports:

1

From any workspace view or report in the web interface, select GO. The GO menu
appears.

If the Flow Monitor section is not visible, click Flow Monitor. The Flow section of the GO
menu appears.

Select Configure > Applications. The Configure Applications dialog appears.

Click New to configure a new application definition. The Map Ports to Applications
dialog appears.

In Name, enter the name of the application.
In Port, enter the port number over which the traffic is sent.
In Protocols, select the protocols monitored on the port.
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8
9

If the Port to Application Mapping applies to the entire network, select Global.

If the Port to Application Mapping applies to a specific subnet, deselect Global and
enter the Subnet address using valid CIDR notation.

10 Click Save to save changes.
11 When the port to application mapping is complete, click OK. The Configure

Applications dialog appears.

Classifying traffic that is considered unclassified

In Flow Monitor, for traffic to be considered "unclassified," both the port from which the data
is sent, or the source port, and the receiving, or destination port, must not be classified in the
Flow Ports dialog. If either the source or destination port is classified, the traffic is associated
with the application of the classified port.

You can classify traffic that is considered unclassified by classifying the source and/or
destination ports over which the traffic is transmitted via the Flow Unclassified Traffic dialog.

To classify a source port:

1

From any workspace view or report in the web interface, select GO. The GO menu
appears.

If the Flow Monitor section is not visible, click Flow Monitor. The Flow section of the GO
menu appears.

Select Configure > Flow Unclassified Traffic. The Flow Unclassified Traffic dialog
appears.

Use the list fields at the top of the dialog to manipulate the port data displayed in this
dialog.

= Select an Interface over which unclassified traffic is transmitting.

= Select a Traffic direction (Inbound, Outbound, Inbound and Outbound, Bounce) in
which the unclassified traffic is traveling.

= Select afilter (Conversations; Source IP, Port; Source Port; Destination IP, Port;
Destination Port) by which to group the unclassified traffic from the Group by field.

To begin monitoring a source port, select the port from the list, then click Classify Src
Port.

To classify a destination port:

1

From any workspace view or report in the web interface, select GO. The GO menu
appears.

If the Flow Monitor section is not visible, click Flow Monitor. The Flow section of the GO
menu appears.

Select Configure > Flow Unclassified Traffic. The Flow Unclassified Traffic dialog
appears.
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4 Use the list fields at the top of the dialog to manipulate the port data displayed in this
dialog.

= Select an Interface over which unclassified traffic is transmitting.

= Select a Traffic direction (Inbound, Outbound, Inbound and Outbound, Bounce) in
which the unclassified traffic is traveling.

= Select a filter (Conversations; Source IP, Port; Source Port; Destination IP, Port; Destination
Port) by which to group the unclassified traffic from the Group by field.

5 To begin monitoring a destination port, select the port from the list, then click Classify
Dst Port.

Configuring data roll-up intervals

Flow Monitor is designed to serve two primary purposes:

= To give a minute-by-minute view of recent network traffic.

= To give an overview of historical network traffic.

To accomplish these goals while keeping the size of its database reasonable, Flow Monitor
uses a process of summarizing data at certain time intervals.

By default, Flow Monitor rolls up data on this schedule:

= Complete raw data (which is collected every other minute and provides the detailed view
of recent traffic) is kept for 4 hours.

= After 4 hours, raw data is summarized into hourly averages.
= After 1 days, hourly averages are summarized into daily averages.
= After 3 days, daily data is archived.

= After 7 days, archive data is purged from the archive database.

You can configure the intervals to roll up data more or less frequently depending on your
network's size and traffic volume.

To set data roll up time intervals:

1 From any workspace view or report in the web interface, select GO. The GO menu
appears.

2 If the Flow Monitor section is not visible, click Flow Monitor. The Flow section of the GO
menu appears.

3 Select Configure > Flow Settings. The Flow Settings dialog appears.
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4 Under Report Data, customize the roll up intervals to meet your requirements.

@ Important: For recommended settings based on your network's size and characteristics, see
the WhatsUp Flow Monitor Performance Tuning Guide
http://www.whatsupgold.com/wugNFv123PerfTuning.

= Data collection interval. Select how often Flow Monitor writes raw data from its sources
to the database. You may select 1, 2, 3, 4, 5, or 10 minutes. By default, raw data is written
to the database every 2 minutes.

r Note: Modifying collection interval settings affects the granularity you see in Flow Monitor
reports. If the interval is set to 5 minutes, you cannot distinguish traffic collected during the
first minute from traffic collected during the fourth minute.

= Resolve private address interval. When the Flow Monitor collector service encounters
an IP address, it tries to determine information about the host attached to the IP address.
After this information is resolved, it is stored in the Flow Monitor database. Enter the
interval (in hours) that you want Flow Monitor to wait, before it checks the private IP
address again, to resolve information that may have changed for the address. By default,
private addresses are resolved every 48 hours.

= Resolve public address interval. When the Flow Monitor collector service encounters an
IP address, it tries to determine information about the host attached to the IP address.
After this information is resolved, it is stored in the Flow Monitor database. Enter the
interval (in hours) that you want Flow Monitor to wait, before it checks the public IP
address again, to resolve information that may have changed on the address. By default,
public addresses are resolved every 720 hours (30 days).

o4 Tip: Because public IP addresses are less likely to be changed, you may want to use longer
intervals than used for the Resolve private address interval option.

= Expire unclassified traffic after. Enter the number of hours after which Flow Monitor
should purge unclassified traffic. Unclassified traffic is traffic transmitted over ports that
are currently not monitored by Flow Monitor. By default, this option is set to 0 (zero),
which causes Flow Monitor to aggregate and retain data for all unclassified ports as a
single value; detailed information about the individual unclassified ports over which
traffic was transmitted is immediately discarded.

I;j Note: The collector will purge any unclassified data that has no activity after the Expire
unclassified traffic after value is satisfied.

Data Cleanup

You can use the data cleanup section of the Flow Monitor Settings dialog to set data cleanup
parameters for both flow data and interface data. Periodic roll-up and archival of flow data
minimizes system resources needed for data storage.
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Flow Data Cleanup Settings

Flow data includes many parameters (input and output interfaces, source and destination IP
addresses, port numbers, byte rates, flow end times, etc.) which while useful in providing
information, may quickly fill available storage. While rolling up the data makes for efficient
storage, you may lose time related information about individual flows. The following
parameters are used to control the cleanup of flow data.

= Roll up raw data after. Enter the number of hours of raw flow data you would like to
maintain. This setting establishes a sliding time window of raw data that spans the
specified period. Raw data that reaches the end of the period is rolled up. The roll up of
raw data happens every hour on the hour. After data has been rolled up, Flow Monitor
can only report using the hourly summations. By default, raw data is rolled up after 4
hours.

4 Caution: While the default settings for data cleanup are conservative, when you modify the
roll-up settings it can directly affect the size of the Flow Monitor databases and the
performance of the application. We recommend that you modify these settings cautiously,
and monitor the effects of changes to these settings on database size and application
performance.

= Roll up hourly data after. Enter the number of days you would like to maintain hourly
data. This setting establishes a sliding time window of hourly data that spans the
specified number of days. As hourly data ages beyond this period it is rolled up. The roll
up of hourly data takes place daily. After hourly datais rolled up, Flow Monitor can only
report aggregated totals for the entire 24-hour block of time. By default, hourly data is
maintained for 1 day.

= Archive daily data after. Enter the number of days of daily data you would like to
maintain before archiving. This setting establishes a sliding time window of daily data
that spans the specified number of days. As daily data ages beyond this period, it is
archived. Flow Monitor continues to have visibility into archived data with some
restrictions. By default, daily data is archived after 3 days.

= Expire archive data after. Enter the number of days of daily data you would like to
maintain in the archive database. This setting establishes a sliding time window of
archived daily data that spans the specified number of days. As the archived daily data
ages beyond this period it is purged from the database. After archived data is purged,
Flow Monitor can no longer report on the data. By default, archive data is purged from
the database after 7 days.

Interface Data Cleanup Settings

Raw interface data is provided by the flow collector, or the collector can be configured to
collect raw interface data directly from the network device when the collector is receiving
sampled flow data. This raw interface data is used to represent total interface traffic for the
period and to calculate 95th percentile values for the Interface Overview and Interface Usage
reports. Because of the data compaction, interface data has a smaller impact on data storage,
so it can be maintained for longer periods of time.
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The following parameters are used to control the clean up of interface data.

Roll up raw data after. Enter the number of days of raw interface data you would like to
maintain. This setting establishes a sliding time window of raw interface data that spans
the specified number of days. As raw interface data ages beyond this point it is rolled up.
After data has been rolled up, Flow Monitor can only report using the summations
produced in the roll-up process. By default, raw interface data is rolled up after 8 days.

= Caution: While the default settings for data cleanup are conservative, when you modify the

roll-up settings it can directly affect the size of the Flow Monitor databases and the
performance of the application. We recommend that you modify these settings cautiously,
and monitor the effects of changes to these settings on database size and application
performance.

25 Important: If 95th percentile values are going to be used for billing purposes, you should

maintain a set of raw interface data that matches the billing period to ensure accurate
results. To gather the data needed to calculate the 95th percentile values for the interface,
set the Roll up raw data after setting for Interface Data to match or exceed the billing
period.

Roll up hourly data after. Enter the number of days you would like to maintain hourly
interface data. This setting establishes a sliding time window of hourly interface data that
spans the specified number of days. As hourly data ages beyond this period it is rolled up.
The roll up of hourly interface data takes place daily. After hourly interface data is rolled
up, Flow Monitor can only report aggregated totals for the entire 24-hour block of time.
By default, hourly interface data is maintained for 35 days.

Archive daily data after. Enter the number of days of daily interface data you would like
to maintain before archiving. This setting establishes a sliding time window of daily
interface data that spans the specified number of days. As daily interface data ages
beyond this period, it is archived. Flow Monitor continues to have visibility into archived
interface data. By default, daily interface data is archived after 180 days.

Expire archive data after. Enter the number of days of daily interface data you would
like to maintain in the archive database. This setting establishes a sliding time window of
archived daily interface data that spans the specified number of days. As the archived
daily interface data ages beyond this period it is purged from the database. After archived
interface data is purged, Flow Monitor can no longer report on the data. By default,
archive interface data is purged from the database after 365 days.

Click OK to save changes.

@ Important: Any changes made to data roll up intervals are not enforced until the Flow

Monitor collector service is restarted. For more information, see Stopping or restarting the
collector (on page 33).
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Managing users and user rights

User accounts and user rights serve two purposes in Flow Monitor:

= User rights govern who can access Flow Monitor reports from, or add Flow Monitor
workspace reports to, the main WhatsUp Gold web interface.

= User rights govern who can modify the Flow Monitor configuration.

To grant a user the right to view Flow Monitor reports and data:

m Note: To complete this procedure, you must be logged in as a user who has been granted
the Manage Users right in WhatsUp Gold.

1 From the web interface, select GO. The GO menu appears.

2 If the WhatsUp section is not visible, click WhatsUp. The WhatsUp section of the GO
menu appears.

3 Select Configure > Manage Users. The Manage Users dialog appears.

4 Select the user to which you want to grant rights to view Flow Monitor reports, then
click Edit. The Edit User dialog appears.

5 Under Userrights, in the Flow Monitor section, select Access Flow Reports.
6 Click OKto save changes.

To grant a user the right to configure Flow Monitor:
1 From the web interface, select GO. The GO menu appears.

2 If the WhatsUp section is not visible, click WhatsUp. The WhatsUp section of the GO
menu appears.

w

Select Configure > Manage Users. The Manage Users dialog appears.

Select the user you want to allow to configure Flow Monitor, then click Edit. The Edit
User dialog appears.

5 Under User rights, in the Flow section, select Configure Flow Monitor.
6 Click OKto save changes.

H

To block a user from viewing Flow Monitor data for a specific Flow Monitor source:
1 From the web interface, select GO. The GO menu appears.

2 If the Flow Monitor section is not visible, click Flow Mon. The Flow Monitor section of
the GO menu appears.

3 C(lick Configure > Flow Sources. The Flow Sources dialog appears.
4 Select a source, then click Access Rights. The Flow Source Access Rights dialog appears.
5 To block a user or multiple users, select the specific user(s) from the list of usernames by

clicking inside a check box in the Block Access column.

€= Tip: You can Select All users, or Deselect All users.
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Click OK to save changes.

Note: In order for a user to be able to block access for other WhatsUp Gold users, the user
must have the Manage Users access right. Additionally, the user for which you are trying to
block access for should not have this right, as this will allow them to block access for other
users.

more information on managing user accounts, see Managing Users in the WhatsUp Gold

User Guide.

Setting the logging level

You can specify the level of information that is recorded for the Flow Log via the Flow
Settings dialog.

LTT Note: The logging level that you specify on the Flow Settings dialog determines the level of

data that Flow Monitor records, whereas the logging level that you specify on the Flow Log
report page determines the level of data displayed within the report.

@ Important: Keep in mind that if you choose the Normal or Errors Only levels, you will not be

able to view the Verbose level from the Flow Log report page.

To set the Flow Monitor logging level:

1

From any workspace view or report in the web interface, select GO. The GO menu
appears.

If the Flow Monitor section is not visible, click Flow Monitor. The Flow section of the GO
menu appears.

Select Configure > Flow Settings. The Flow Settings dialog appears.
Under General, select the Log level.

Normal. Select this option to record errors and some general event information.

Verbose Logging. Select this option to record more detailed information than normal
logging. This option can create a large number of records and may be resource intensive;
it is only recommended for use while troubleshooting issues.

Errors Only. Select this option to record only events that register as errors.
Click OK to save changes.
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Backing up and restoring the Flow Monitor
databases

You can use the WhatsUp Gold database utilities to back up and restore the WhatsUp Flow
Monitor database and archive database.

To access the database utilities:

From the WhatsUp Gold console main menu, select Tools > Database Utilities.

Using the database backup and restore backup utility for Flow
Monitor

You can back up your complete Flow Monitor SQL Server database and archive database to
any mapped directory you have on your network. Database backups are saved as .bak files

and can be restored at any time. Restoring a .bak file overwrites your current database with
the data in a .bak file.

@ Important: Make sure that you close the Discovery Console before running a database
restore. Running the Discovery Console while running a database restore could crash the
console.

@ Important: You can use this feature with any local instance of SQL Server whose databases
are named Netflow and NFArchive. This feature does not work with remote databases.

@ Important: We strongly suggest that you backup and restore the Netflow database and
archive database as a set. When you backup the Netflow database, you should also backup
the archive database. Similarly, when you restore the Netflow database, you should restore
the archive database to the version that was most recently generated by the Netflow
database.

If you want to back up the SQL database to a mapped drive, the Logon settings for the SQL
Server (WHATSUP) (or your customized SQL service) must have write access to the mapped
drive.

To change the SQL database logon settings:

1 Click Start > Control Panel > Administrative Tools > Services, then double-click the
SQL Server (WHATSUP) service.The SQL Service Properties dialog appears.

2 (lick the Log On tab on the Properties dialog.
3 Change the account logon settings as required.

L'Tj Note: This is a complete backup and restore, so any change that you make after the backup
will be overwritten and lost after restoring a backup.
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To access the Database Utilities Backup and Restore features:

From the main menu in the WhatsUp Gold console, select Tools > Database Utilities > Back
Up Flow Monitor Current or Archive Database

-or-

select Tools > Database Utilities > Restore Flow Monitor Current or Archive Database

Stopping or restarting the collector

You can restart the Flow Collector Service through Flow Monitor, WhatsUp Gold, and
Windows.

To stop or restart the Flow Collector Service through Flow Monitor:

1 From any workspace view or report in the web interface, select GO. The GO menu
appears.

2 Click the Flow Monitor icon. The Flow Monitor Home page appears.

3 Click the Flow Service icon in the bottom right corner of the page. The Flow Service
dialog appears.

4 Click Stop or Restart. A progress dialog appears as the Flow Data Collector Service
stops. After the action is completed, the Flow Service dialog appears.

5 Click OK.
To restart the Flow Collector Service through WhatsUp Gold:

From the main menu of the WhatsUp Gold console, select Tools > Service > Restart Flow
collector. The service restarts.

To stop or restart the Flow Collector through the WhatsUp Services Controller:
1 Go to the WhatsUp Services Controller dialog.
= From the console, select Tools > Services Manager. The WhatsUp Services Controller

dialog appears.
- Or -

= From the the Programs menu, click Ipswitch WhatsUp Gold > Utilities > NMService
Manager. The WhatsUp Services Controller dialog appears.

2 Inthe WhatsUp Services Controller, select the Flow Collector Service by clicking its
service Description.

3 Click Stop or Restart.
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Using Flow Groups

In some cases, you may prefer to track a range of IP addresses as belonging to a different
domain, top level domain, or country than the IP addresses resolve to. For example, internal
IP addresses do not usually have host names registered on a domain name server, so Flow
Monitor cannot automatically determine their domains, top level domains, or countries.

To overcome this limitation, Flow Monitor lets you use Groups to override the domain, top
level domain, and country of ranges of IP addresses so that each group can be tracked as a
whole. This allows you to easily track sections of your internal network so that you can view
reports by divisions, departments, or other groupings.

Y Tip: After you configure a group, you can use that group's name to filter reports to show only
the traffic sent to or received by devices that belong to the group.

To create or edit a group:

1 From any workspace view or report in the web interface, select GO. The GO menu
appears.

2 If the Flow Monitor section is not visible, click Flow Monitor. The Flow section of the GO
menu appears.

3 Select Configure > Flow Groups. The Flow Groups dialog appears.
4 Click New. The Flow Group dialog appears.

- or -
Select a group, then click Edit. The Flow Group dialog appears.
5 Enter or select the appropriate information in the following fields.

= Group. Enter a name for the Flow group.
= [P Range Start. Enter the first IP address for the Flow source group range.
= [P Range End. Enter the last IP address for the Flow source group range.

= Domain. Enter the domain that you want Flow Monitor to report for the specified IP
addresses. For example, yourcompany . com.

= Top Level Domain. Select the domain that you want Flow Monitor to report for the
specified IP addresses. For example, com.

= Country. Select the country that you want Flow Monitor to report for the specified IP
addresses.

6 Click OKto save changes.
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About the Flow Monitor Home page

The Flow Monitor Home page provides overview information about the network sources that
Flow Monitor is monitoring. Use this page to view high-level information about network
traffic and flows and to drill deeper into each interface for more detailed information. You can
also access Flow Monitor database and Data Collector Service information using the links at
the bottom right side of the page.
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i h 192.168.3.56 227 Nlows per minute ® Extemal
® %‘ 182 168.30.2 3948 flows per minute Traffic during th last half hour
i %.QA'L-CISC 04506 ipswitch.com 14985 flowes per minute o
= %'L' sthjunipar2220 92 flows per minute 8
i h.&'L-‘J'OIP Ipswitch.com 349 Nlows per minute A
B h cizcolB12 ipswitch.com SF75 flows per minute E-
4
™ External a1z 407 Mops 1.2% 1.21 Mbps
W intemal 3 4% 137 Maps IRE 4107 Mbps 2
® h dev-2621 ipswitch.com B15 flows per minute l T
1031 am 1046 s 11:01 am
& W 0A2821 ipswitch com 400 flawes pet minule
W Ireming Traftk:
B Ouigeing Traffic
LLast incoming details 142010 11:00:00 AM
ILast outgoing details 1042010 11:00:00 AM
Interface typa Ethernat CSMACD
In speed 100.00 Mbos
Out spaed 100.00 Mbps
Status Up
¥ Inlerface details report
W Irferface ovemiew IEpOr
™ nterface proparies

TPSWITEH Ll S8 Tr &inir, Inc 1 Framium Editan s I Bulid 239

Flow Monitor sources

The left side of the page lists each of the monitored sources and the interfaces associated
with each source.
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=  Flow Sources. Routers and switches that have been configured to send flow data to Flow
Monitor and are enabled in Flow Monitor are listed in this column. In the list, sources are
organized at the top level. Associated interfaces for each source are below the source
name. Use the =collapse and =expand buttons to show or hide source interfaces. For
each source, the number of flows per minute (fpm) for Flow devices and samples per
minute (spm) for sFlow devices generated by all interfaces on the selected source over
the the last period is displayed.

I’j Note: Interfaces can be hidden; if you do not see an interface listed on this workspace report,
check to see if it has been hidden via the Flow Interface dialog.

¢ Tip:If you do not see a source listed that you would like to monitor, first go to the Flow
Sources dialog to configure source settings. If you still do not see the router listed, check to
see that the router is configured to send flow data. For more information, see Configuring
Flow Monitor sources (on page 7) or Configuring sFlow sources.

= Incoming Interface Traffic. Incoming traffic is reported as a percentage of usage
according to the interface's speed, and number of incoming bytes per second (bps) based
on the last traffic to enter the interface.

= Outgoing Interface Traffic. Outgoing traffic is reported as a percentage of usage
according to the interface's speed, and as the number of outgoing bytes per second (bps)
based on the last traffic to leave the interface.

Source and interface details

The right side of the page gives detailed information about a selected source or interface.

LT’j Note: If you have not enabled Flow sources at this time, a Welcome workspace report is
displayed on the right side of the Flow Monitor Home page. Consult this workspace report
for information on configuring your routers to send Flow data, and for other general Flow
Monitor configuration information.

Source details
Click a source device in the list to view the Source details on the right side of the Home page.

= [P address. The source router's IP address.
=  Flow protocol. The version of Flow or sFlow the source uses when exporting flow data.

= Sample rate. The rate at which the source is polling interface data.

I’j Note: The sample rate appears for any source sending sampled NetFlow data.

= Packets received. The number of packets the collector received from the source since
the collector service was started.
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Packets lost. The number of packets sent from the source but not received by the
collector since the collector service was started.

Reliability. The percentage of packets received versus packets lost by the source since
the collector service was started.

Flow rate. The number of flows per minute (fpm) reported by the source during the last
collection interval.

Last active. The last time traffic was received from the source.

Flow traffic status. Whether Flow Monitor is receiving traffic from the source; either
receiving, or not receiving.

T Note: If any traffic has been received within the last 30 minutes, the traffic status is displayed

as receiving.

Use the Source Properties link at the bottom of the source details to view the Flow Source
dialog and use the Interface links to view the WhatsUp Gold Interface Details report.

T Note: A link for the WhatsUp Gold Interface Details report appears only if the source is

monitored in WhatsUp Gold.

Interface details

Click a source device interface in the list to view the Interface details on the right side of the
Home page. The Interface Traffic report for the last collection interval is displayed at the top
of the interface's details.

Last incoming details. The last time traffic transmitted over the incoming interface.
Last outgoing details. The last time traffic transmitted over the outgoing interface.
Interface type. The type of the interface; for example, Ethernet CSMA/CD.

In speed. The speed at which data is flowing to the interface.

Out speed. The speed at which data is flowing from the interface.

Status. The status of the interface; either Up, Down, or Unknown.

Use the links at the bottom of the interface details to view the Interface Details and
Interface Overview reports, as well as the Flow Interface Properties.
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Flow Monitor database and service icons

Database and service icons are located in the bottom right of the page. These icons display
information about the Flow Monitor database, archive database, and Flow Monitor service.
Position the mouse cursor over an icon to view size and status information. For more
information, please see About Flow Monitor database and service icons.

M Position the mouse cursor over the Flow Monitor Database icon to view the database
edition and current size (in megabytes). Click the icon to view the Flow Monitor Database
Properties.

ﬂ Position the mouse cursor over the Flow Monitor Archive Database icon (located to the

right of the Flow Database icon) to view the archive database edition and current size (in
megabytes). Click the icon to view the Flow Monitor Database Properties.

Position the mouse cursor over the Flow Service icon to view the service status. Click the
icon to view the Flow Monitor Service Properties.

<)

L’T Note: If you are using Internet Information Services (IIS) as the web server for WhatsUp Gold
and it is running as a user that does not have administrative privileges, the web interface
cannot interact with Windows services. This means that you cannot view the status of
services or start, stop, or restart services from the web interface. In this case, you must log in
to Windows to manage services through the Control Panel.

Exporting, emailing, scheduling and managing reports

Use the Options E icon, at the top right of the page, to select and manage the following
options: Export reports, Email / Schedule Reports, or manage Scheduled Reports. For more
information see, Using Scheduled Reports in Flow Monitor: printing, exporting, and emailing
reports (on page 67).

=4 Tip: Use the right-click menu on this page to view and configure parts of the application. For
more information, see Using the Flow Monitor Home page right-click menu (on page 39).

o4 Tip: Use the Host Search tool in the upper-right side of the page to locate traffic to or from a
host or group of hosts. For more information, see Searching for specific hosts (on page 40).

=4 Tip: Use the Alert Center tab to access the WhatsUp Gold Alert Center.
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About Flow Monitor database and service icons

The Flow Monitor database, archive database, and service icons are displayed in the lower
right corner of the Flow Monitor Home Monitor page. Position the mouse cursor over an icon
to view size and status information.

Icon Description
% When the database and archive database icons are green, the database
i sizes are at healthy levels.
‘ﬁ When the database and archive database icon are red, the database sizes
i are too large, or there is a database error.
G When the Flow Monitor service icon is green, the service is running.
When the Flow Monitor service icon is red, the service has stopped.

Flow Monitor Database Properties

To view the properties for the Flow Monitor Database and Archive Database, click the
database or archive database icons.

Using the Flow Monitor Home page right-click menu

From the Flow Monitor Home page, you can right-click on a source or interface to access a
right-click menu with links to common tasks.

Note: The right-click menu shows options available for the object on which you right-click.
Depending on the object you right-click, the available options may vary.

Reports
%, Search...

825 flows per minute

D flows per minute

B flows per minute

e e B447 flows per minute
Configure Sathings...
Properties it
- | Ports...
Groups. ..
Types of Service...
263,68 bps Unclassified Traffic, .
17.56 bps Data Export Settings. .
Database Mainkanance. ..
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The right-click menu includes these options:

Reports. Select this option to open the Reports tab.

Host Search. Select this option to open the Host Search dialog. From this dialog, you can
search all sources and interfaces for traffic that uses a specific host. For more information,
see Searching for specific hosts (on page 40).

Interface Details. Select this option to view the Interface Details report for the selected
interface. This report is a collection of views that provide quick insight into the traffic
transmitting across a specific interface.

Interface Overview. Select this option to view the Interface Overview report for the
selected interface. This report is a collection of Flow Monitor workspace reports that
provide a summary of the traffic and utilization of a specific interface.

Configure. Select a configuration option:

Flow Settings. Select this option to configure general settings in the Flow Settings
dialog.

Flow Sources. Select this option to open the Flow Sources dialog. From this dialog, you
can view and change a device source configuration or stop and start data collection from
a source, select a source and click Edit.

Flow Ports. Select this option to open the Flow Ports dialog. From this dialog, you can
see the definitions of applications (traffic over a given port using one or more protocols)
that Flow Monitor is monitoring. You can also use this dialog to define new applications.

Flow Groups. Select this option to open the Flow Groups dialog. From this dialog, you
can create, change, or delete an IP range of devices, in a Flow Group, that may not have
been automatically associated with a domain, top level domain, or country.

Flow Types of Service. Select this option to open the Flow Types of Service dialog. From
this dialog, you can view and rename Flow Types of Service to make the Flow Top Types
of Service workspace report more meaningful and easy to identify.

Flow Unclassified Traffic. Select this option to open the Flow Unclassified Traffic dialog.
From this dialog, you can map ports that have not been mapped to an application and
are currently unmonitored.

Flow Data Export Settings. Select this option to configure the parameters for exporting
Flow Monitor report data.

Properties. Select this option to open either the Flow Source Properties dialog, or the
Flow Interface Properties dialog. From these dialogs, you can view information about the
selected source or interface properties.
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Searching reports for specific host names

The Host Search tool allows you to search across the interfaces of all sources to find traffic to
or from a specific host.

The Host Search tool is available in several locations throughout Flow Monitor and WhatsUp
Gold. Although the navigation to the Host Search tool varies, the search process is the same
after you navigate to the feature.

To perform a host search from the GO menu:
1 From any workspace view or report in the web interface, select GO. The GO menu
appears.

2 If the Flow Monitor section of the GO menu is not visible, click Flow Monitor. The Flow
Monitor section of the GO menu appears.

3 Select Reports > Search. The Host Search dialog appears.

wd Al Reporks

¥ Interface Details
# Interface Cverview

@ Lo
i@} Bandwidth Usage

@ Tnterface Ussge

4 Select a search criteria from the list (contains, does not contain, is, is not, starts with,
ends with).

5 Enter an alphanumeric search criteria in the blank field.

6 Click Search. After the search has completed, the dialog expands to display the search
results list.

7 For more detail on a host in the list, select it, then click OK. The Flow Select Interface
dialog for the selected interface appears.
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To perform a host search from the right-click menu:

1 From the Flow Home page, right-click a source or an interface. The Flow Home page
right-click menu appears.

Interface Detals

Interface Overview
Configure

Properties

_or-

From the WhatsUp Devices tab, right-click a device. The WhatsUp Devices right-click
menu appears.

New Device...

New Group...

New Dynamic Group...
Device Reports...
Group Reports.,,
Copy

Move

Delete

Pol Now

2 Select Search from the Flow Monitor right-click menu, or Host Search from the
WhatsUp right-click menu. The Host Search dialog appears.

3 Select a search criteria from the list (contains, does not contain, is, is not, starts with,
ends with).

4 Enter an alphanumeric search criteria in the blank field.

5 Click Search. After the search has completed, the dialog expands to display the search
results list.

6 For more detail on a host in the list, select it, then click OK. The Flow Select Interface
dialog for the selected interface appears.
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To perform a host search from the Flow Home page or Reports tab:

Flow Monitor Reports

%4 Flow Monitor £ Alert Center

Flow Monitor Reports

¥ Interface Details
A configurable detail view of a speciied interface

¥ Interface Overview
An overview of interface traffic including a break down of in and out trafic and trafic over time

@ Log
A record of messages generated by Flow Monitor

& Bandwidth Usage
Aview of the amount of incoming and outgoing bandwidth used by groups or hosts

@ Interface Usage
Aview of the amount of incoming and autgoing bandwidth used by intedaces

@ VhatsUp Reports: Go t the WhataUp report overview acresn

& Alert Center Reports: Go o the Alert Center report overview screen

gt guanttten gl N e P NN ™ T

1 From the Flow Home page or Reports tab, enter an alphanumeric value in Host Search,
then press Enter. The Host Search dialog appears, populated with the results of the host

search.

The default search criteria for the host search is "contains." Adjust the search criteria as

needed to perform the search you desire, then click Search. The dialog re-populates with

the results of the new search.

2 For more detail on a host in the list, select it, then click OK. The Flow Select Interface

dialog for the selected interface appears.
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About the Flow Monitor Reports tab

The Flow Monitor Reports tab lists the available Flow Monitor reports.

Flow Monitor Reports
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These Flow Monitor reports are available:

= Interface Details

= Interface Overview
=  Flow Monitor Log
= Bandwidth Usage

= |nterface Usage

To view a report, double-click its title in the list.

':i/ Tip: You can access the WhatsUp Gold reports by clicking the WhatsUp Reports Quick Link.

About the Interface Details report

The Interface Details report is a collection workspace reports that provide quick insight into

the traffic flowing through a specific interface.

Interface Details
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When you first access the Interface Details report, it shows the General view for all traffic on

the

&

For

selected interface. You can refine the report in several ways.

Select a different interface. Use the Interface list at the top of the page to select the
interface for which the report data displays.

Changing the traffic direction. Use the Traffic direction list at the top of the page to
select a direction for which the report data is displayed.

Selecting a different date range. Use the Date range list at the top of the report to
change the timeframe for which report data is displayed. If you select Custom, you will be
prompted to enter a start and end time for the date range. For more information, see
Filtering by date and time (on page 49).

Filter report results. You can filter the current workspace reports to show only data
matching search criteria. For more information, see Filtering by keywords (on page 50). You
can also drill-down into certain report entries. For more information, see Filtering by
drilling-down (on page 52).

Managing report views. Use the Workspace View list at the top of the page to switch
between the pre-configured report view and report views you've configured, or to create
new report views.

Note: sFlow data is sent every x number of packets (configurable on the sFlow device),
whereas typically all NetFlow data is collected and monitored. This means that sFlow data
provides a sampling of network traffic data, whereas Flow data provides all network traffic
data.

sFlow data sampling methods may result in Interface Overview and Interface Detail reports
that appear to have more or less traffic than is shown in the Flow Monitor Home page source
information. This is because the sampled data shown in the Interface Overview and Interface
Detail reports are derived the sampled data and the Flow Monitor Home page source
information is derived from the total interface traffic data.

more information on how to refine the low Interface Details report, see Filtering data in a

view (on page 48).

\ ‘:‘-’

Tip: You can view the Interface Overview (on page 54) report for the selected interface by
clicking Interface Overview at the top of the page.
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General view

The Flow Monitor Interface Details' main view is the General view. The General view displays
an overview of traffic for the selected interface.

By default, the report contains the following Interface Details workspace reports:

=  Top Protocols

= Top Applications

= Top Senders

=  Top Receivers

=  Top Sender Domains

=  Top Receiver Domains

You can add additional Interface Details workspace reports to the General view, or delete an
existing workspace report from both the Edit Layout button and the Workspace View list.
For more information, see Managing Flow Monitor Interface Details report views (on page 47).

4 Tip: Click Edit Layout to add a workspace report to the currently selected workspace view.

frj Note: Sender workspace reports are displayed on the left side of the report, while receiver
workspace reports are displayed on the right side. A page with no sender or receiver reports
displays workspace reports in one column.

Managing report views

You can customize the default view, General, of the Flow Monitor Interface Details report, or
create new views tailored to your needs.

To customize an existing view:

1 From any workspace view or report in the web interface, select GO. The GO menu
appears.

2 Click the Flow Monitor icon. The Flow Monitor Home page appears.

3 From the list of Flow sources, select an interface. The Flow Monitor Interface Details
report appears.

4 From the Workspace View list in the toolbar, select the view you want to customize.
The view you select appears.

5 Inthe toolbar, click Edit View. The Configure Flow Interface Report dialog appears.
6 Customize the view.

a) In View, enter a descriptive name for the view. This name appears in the View select
list in the toolbar.

b) From the list of available reports, select the checkboxes next to the names of the
reports you want to include in this view.
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7

Click OK to save changes. The customized Flow Interface Details report appears.

To create a new Interface Details report view:

1

From any workspace view or report in the web interface, select GO. The GO menu
appears.

Click the Flow Monitor icon. The Flow Monitor Home page appears.

From the list of Flow sources, select an interface. The Flow Monitor Interface Details
report appears.

From the Workspace View select list in the toolbar, select Add View. The Configure
Flow Interface Report dialog appears.

Configure the new view.

a) InView, enter a descriptive name for the view. This name appears in the View select
list in the toolbar.

b) From the list of available reports, select the checkboxes next to the names of the
reports you want to include in this view.

Click OK to save changes. The Flow Monitor Interface Details report appears and
displays the new view.

To delete a Flow Interface Details report view:

1

From any workspace view or report in the web interface, select GO. The GO menu
appears.

Click the Flow Monitor icon. The Flow Monitor Home page appears.

From the list of Flow sources, select an interface. The Flow Monitor Interface Details
report appears.

From the Workspace View select list in the toolbar, select the view you want to delete.
The view you select appears.

From the Workspace View select list in the toolbar, select Delete Current View. You
will be prompted to confirm you want to delete the current view.

Verify that you want to delete the view, then click Yes. The report view is deleted and
the Flow Monitor Interface Details report appears.

Selecting an interface

The Flow Monitor Interface Details, Interface Overview, and Bandwidth Usage reports display
data in context of a single interface on the source router or switch.

To change the interface for which data is reported:

1

From the toolbar at the top of the screen, click the Interface list. A list of all of the
available interfaces appears.

Select the interface for which you want to view the current report. The report refreshes
with data from the selected interface.

48



Using WhatsUp Gold Flow Monitor

Filtering data in a view

You can filter the data in the Interface Details report in several ways.

= Date and time
»  Traffic direction

= Keywords

After you apply a filter, the report data refreshes to display data relevant to the applied filter.

Filtering by date and time

By default, the Interface Details report views shows data for the previous fifteen minutes.

To change the time frame for which the Interface Details report displays data:

1 Atthe top of the report, select Date range. A list of common time periods appears.
2 Select one of the available time periods.

3 If you select Custom, the Start time and End time fields appear.

LTF Note: Flow Monitor only displays data from one database at a time, and by default, displays
the most current data. If you select a time period that includes data stored in both the Flow
Monitor database and the Flow Archive database, a note displays below the date range
informing you that not all data is shown for the specified date range. For example, if you
select a date that includes 39 days of archived data, and one hour of current data, one hour
of current data is displayed in the report. You must modify the report's date to view the
archived data.

a) In Start time, select the date and time that corresponds with the beginning of the
time period for which you want to see data.

b) In End time, select the date and time that corresponds with the end of the time
period for which you want to see data.

LTF Note: When you set a start and end time for report data, you will most likely see a larger data
total than expected. This is because the data displayed is a summation of the start time, or
data greater than or equal to the selected start time, and the end time, or data less than or
equal to the selected end time.

4 C(Click Go to apply the filter to the report. The report refreshes showing only data from
the time period selected.
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About the Report Zoom Tool

Use the zoom tool to navigate through a report. The zoom tool is tied-in to the report
date/time picker and will change the date and time of a report as you page up and down, or
zoom in and out.

(o] Page up Moves the report date forward. For example, clicking the Page up button will
move the date from today to tomorrow.

Zoomin Decreases the amount of time displayed in the report. For example, click the
Zoom in button will decrease the display time from 24 hours to 12 hours.

EN| Zoom out Increases the amount of time displayed in the report. For example, clicking the
Zoom out button will increase the display time from 12 hours to 24 hours.

(=] Page down Moves the report date backward. For example, clicking the Page down button
will moved the date from today to yesterday.

Filtering by traffic direction
By default, the Interface Detail report displays information about inbound traffic to the

selected interface.

The router graphic to the right of the Traffic direction list illustrates the direction traffic is
moving in relation to the router.

s -—

In the graphic above, the arrow is pointing to the router, illustrating that traffic is moving
toward the router, and is therefore inbound.

To filter report data by traffic direction:

1 Atthe top of the report, select Traffic direction. A list of available traffic directions
appears.

2 Select a traffic direction.
= Inbound. Select this option to show only data that is being sent to the interface.
= Outbound. Select this option to show only data that is being sent from the interface.

= Inbound and Outbound. Select this option to show both inbound and outbound traffic
for the interface.

= Bounce. Select this option to see traffic that routed into and out of the same interface. In
some cases, this may represent a router misconfiguration.

3 After you select a traffic direction, the report refreshes showing only data from traffic
that matches your selection.
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Filtering by keywords

You can use keyword filters to create complex Flow Monitor interface report views. This is
useful when you need to view data about the traffic generated by a specific computer, to a
specific domain, etc.

After you apply a filter to the Interface Details report, the workspace report that coincides
with the filter reloads with a time graph for the filtered traffic component. For example, if you
apply a filter for the http application, the Top Applications workspace report displays a time
graph of http application use for the time period selected at the top of the Interface Details
report.

Top Applications  (htip) 7 &

EB[CN[EN] OS]

Filtered by: http (80 130.93 MB) | 3§

You can easily determine which workspace report contains the time graph by looking for the
filter enclosed in parenthesis to the right of the workspace report title name.

=4 Tip: You can remove the applied filter by clicking the red X under the time graph.

To filter by keywords:
1 Atthe top of the report, select Add Filter. Filter fields appear below the button.
2 Select the type of filter you want to apply.

= Sender. Show traffic sent by the specified device. You can match a device using its host
name or its IP address.

= Receiver. Show traffic received by the specified device. You can match a device using its
host name or its IP address.

=  Protocol. Show traffic that used the specified protocol (such as UDP, TCP, or ICMP).
= Service. Show traffic that used the specified type of service.

= Application. Show traffic that used the specified application. The keyword must match
the application name as configured in the Flow ports dialog.

=4 Tip: You can enter a port number instead of an application name to show all traffic
transmitting over a certain port.

= Sender Domain. Show traffic sent by hosts on the specified domain.

= Receiver Domain. Show traffic received by hosts on the specified domain.
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Sender Country. Show traffic sent by devices whose IP addresses are registered to the
specified country.

Receiver Country. Show traffic received by devices whose IP addresses are registered to
the specified country.

Sender Group. Show traffic sent by the specified group.
Receiver Group. Show traffic received by the specified group.

Sender TLD. Show traffic sent by domains that have the specified top level domain (such
as.com, .net, .us, or .uk).

Receiver TLD. Show traffic received by domains that have the specified top level domain
(such as .com, .net, .us, or .uk).

ICMP Type. Show traffic by ICMP type.

Packet Size. Show traffic by packet size.
Optionally, click Add Filter to add additional filters.

Click Apply Filters. The report refreshes showing only data that matches the filters you
have configured.

Tip: If you configure a filter incorrectly, you can remove it from the current view by clicking
the red X located to the right of the keyword field.

Filtering by drilling-down

Another way to filter report data is by clicking on report entries, or drilling-down. This method
of report-filtering allows you to dig deeper into data that peaks your interest or raises red
flags—with just one click.

When you click an entry in the farthest-left column of an Interface Details workspace report,
the report reloads using the entry as a filter. Also, you can click inside a workspace report's
graph area to apply afilter.

52



Using WhatsUp Gold Flow Monitor

Similarly to filtering by keywords, after you apply a filter to the report, the workspace report
that coincides with the filter will display a time graph for the filtered traffic component. For
example, if you click an entry in the Sender Country column of the Top Sender Countries
workspace report, the workspace report reloads with a time graph for the country that you

clicked.
Top Sender Countries el ln|
(93.33%)

DE (0.03%)

FR(0.01%)

AU(310%)-

US(3.52%)
Sender Country Bytes Percent of top 5
& Unknown 22119 MB [ 9333%
5 United States 835MB | 352%
™= Germany 7457 KB 0.03%
[ @france 2589 KB 0.01 %
Top Sender Countries  (Au) A& 1E

a0

446 pm S0 pm

Filtered by: AU (7.36 MB) (3¢

Several keyword filters coincide with more than one workspace report and more than one
time graph is displayed after the filter is applied. You can easily distinguish which workspace
reports in the Interface Details report are displaying time graphs by looking for the applied
filter's name in parenthesis next to a report name.

Top Sender Domains ERSNE
Top Sender TLD ERSNE
Top Types of Service ERSNE
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About the Interface Overview report

The Interface Overview report is a collection of Flow Monitor workspace reports that provide
a summary of the traffic and utilization of a specific interface.
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B borring Teal e B Btgaing Tt
. = o =
Incoming Interface Traffic (] | md 1[Z] Outgoing Interface Traffic (] el [3]
Urnamed (37 57%) Unnamesd (30 5%
U [ 0
Urriamesd (350 (0.09%) mjgm:
(1) (0 26%) \rnomed
Ui (3517 1 TE%) E¥) EA02%)
Dutpist Inberface Byies Packets Flows Percent  Input imenface Bytes Packets Flows Percent
Urnamed {3513 20.03 MB 108396 5403 | 176 % Unaamed {351) 11062 MB 504559 SED4 B 202%
L T R T— e s
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The Interface Overview consists of individual Flow Monitor workspace reports that highlight
both incoming and outgoing traffic and utilization for the selected interface.

= Interface Traffic

= |ncoming Interface Traffic

= Qutgoing Interface Traffic

= Incoming Interface Utilization

= Qutgoing Interface Utilization
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By default, the report displays data for the last interface you selected from the Flow Source
list.

W Note: sFlow data is sent every x number of packets (configurable on the sFlow device),
whereas typically all NetFlow data is collected and monitored. This means that sFlow data
provides a sampling of network traffic data, whereas Flow data provides all network traffic
data.
sFlow data sampling methods may result in Interface Overview and Interface Detail reports
that appear to have more or less traffic than is shown in the Flow Monitor Home page source
information. This is because the sampled data shown in the Interface Overview and Interface
Detail reports are derived the sampled data and the Flow Monitor Home page source
information is derived from the total interface traffic data.

There are several ways you can control the data shown in this report.

= Select a different interface. Use the Interface list at the top of the page to select the
interface for which the report data displays.

= Selecting a different date range. Use the Date range list at the top of the report to
change the timeframe for which report data is displayed. If you select Custom, you will be
prompted to enter a start and end time for the date range. For more information, see
Filtering by date and time (on page 49).

4 Tip: You can view the Interface Details report for the selected interface by clicking Interface
Details at the top of the page.

Filtering report data

You can filter the data displayed in the Interface Overview by time and date (on page 55).
After you apply a date and time filter, the report data refreshes to display data relevant to the
applied filter.

Filtering by date and time
By default, the Interface Overview report shows data for the previous fifteen minutes.

To change the time frame for which the Interface Overview report displays data:
1 Atthe top of the report, select Date range. A list of common time periods appears.
2 Select one of the available time periods.
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3 If you select Custom, the Start time and End time fields appear.

m Note: Flow Monitor only displays data from one database at a time, and by default, displays
the most current data. If you select a time period that includes data stored in both the Flow
Monitor database and the Flow Archive database, a note displays below the date range
informing you that not all data is shown for the specified date range. For example, if you
select a date that includes 39 days of archived data, and one hour of current data, one hour
of current data is displayed in the report. You must modify the report's date to view the
archived data.

a) In Start time, select the date and time that corresponds with the beginning of the
time period for which you want to see data.

b) In End time, select the date and time that corresponds with the end of the time
period for which you want to see data.

4 Click Go to apply the filter to the report. The report refreshes showing only data from
the time period selected.

About the Flow Monitor Log

The Flow Monitor Log is a history of system-wide messages generated by Flow Monitor.
When you access the Flow Monitor Log, it shows messages generated during the time period
selected at the top of the report.

Flow Monitor Log

%5 Flow Monitor -8 Reponts ., Alert Centar
Data ranga: |Las1 15 Minutes vI Go Seventy level: | Mormal x

Date ~ Message Sewerity

Thursday, January 14, 2010 02180, Commilting 2:18 PM data took 0.55 seconds, Inserted: 61 {0) hosts, 18724 flows, O UA flows, 31 inte... Mormal
Thursday, January 14, 2010 02:16:0 Commiting 216 PM data took 0.48 seconds, Inserted: 43 {0) hosts, 17645 flows, 0 UA flows, 30 inte... Normal
Thursday, January 14, 2010 02-14.0 Committing 214 PM data took 5 27 seconds, Insered: 45 {0) hosts, 15069 flows, 0 UA flows, 31 inte. . Mormal
Thursday, January 14, 2010 02120 ... Committing 2:12 P data took 0.70 seconds, Inserted: 43 (0) hosts, 14764 flows, 0 UA flows, 31 inte.. Normal
Thursday, January 14, 2010 02:10:0 Commiting 2:10 PM data took 0.92 seconds, Inserted: 63 {0 hosts, 14783 flows, 0 UA flows, 31 inte.. Normal
Thursday, January 14, 2010 02 08:0 Commiting 2:08 PM data took 0.77 seconds, Inserted: 130 {0) hosts, 15916 flows, O UA flows, 31 int.. Normal
Thursday, January 14, 2010 02-06:0 Committing 206 PM data took 0.67 seconds, Inserted: 348 (0) hosts, 16309 flows, O UA flows, 31 int.. Mormal

TPEWITCH e e Training
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Each entry shows the date logged, the message about the activity, and the severity of the
entry.

= Date displays the date the message was logged.

= Message displays the activity message. This message contains the reason for the log

entry, other information, such as error number, which may be useful in troubleshooting.

= Severity displays the logging level of the entries, either Normal, Verbose, or Errors Only.

Y Tip: You can sort the data in the report by clicking on a column title.

Changing the report date and time

Use the Date range list at the top of the report to select a time frame for the report. By
default, the report displays log entries for the previous hour.

LGF Note: Flow Monitor only displays data from one database at a time, and by default, displays
the most current data. If you select a time period that includes data stored in both the Flow
Monitor database and the Flow Monitor Archive database, a note displays below the date
range informing you that not all data is shown for the specified date range. For example, if
you select a date that includes 39 days of archived data, and one hour of current data, one
hour of current data is displayed in the report. You must modify the report's date to view the
archived data.

Changing the report severity/logging level

Use the Severity level list to select a logging level for the report.

= Verbose displays all entries (including all three severity levels).
= Normal displays entries for Normal and Errors Only.

= Errors only displays only error entries.
Exporting, emailing, scheduling and managing reports

Use the Options E icon, at the top right of the page, to select and manage the following
options: Export reports, Email / Schedule Reports, or manage Scheduled Reports. For more
information see, Using Scheduled Reports in Flow Monitor: printing, exporting, and emailing
reports (on page 67).
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Filtering report data

You can filter the Flow Monitor Log by two criteria.

= Date and time (on page 58)
= Severity level (on page 58)

After you apply a filter, the report data refreshes to display data relevant to the applied filter.

Filtering by date and time

By default, the Flow Monitor Log shows data for the previous fifteen minutes.

To change the time frame for which the Flow Monitor Log report displays data:

1 Atthe top of the report, select Date range. A list of common time periods appears.
2 Select one of the available time periods.

3 If you select Custom, the Start time and End time fields appear.

LT Note: Flow Monitor only displays data from one database at a time, and by default, displays
the most current data. If you select a time period that includes data stored in both the Flow
Monitor database and the Flow Archive database, a note displays below the date range
informing you that not all data is shown for the specified date range. For example, if you
select a date that includes 39 days of archived data, and one hour of current data, one hour
of current data is displayed in the report. You must modify the report's date to view the
archived data.

a) In Start time, select the date and time that corresponds with the beginning of the
time period for which you want to see data.

b) In End time, select the date and time that corresponds with the end of the time
period for which you want to see data.

o4 Tip: Use the Standard Business Hours feature to setup reports designed for business hours
only. For more information, see Changing the report date range.

4 C(Click Go to apply the filter to the report. The report refreshes showing only data from
the time period selected.

Filtering by severity level
By default, the Flow Monitor Log displays data for the Normal severity level.

To change the severity level for which the Flow Monitor Log displays data:

1 Atthe top of the report, click the Severity level list. A list of the three available severity
levels appears.

2 Select the severity level for which you want to view report data. The report refreshes
with data for the selected severity level.
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Exporting report data

You can export data displayed in the Flow Monitor Log by clicking the Export button at the
top right of the report.

[T Note: Flow Monitor data is exported according to the parameters set in the Flow Data Export
Settings (on page 80) dialog.

To export report data:

E
1 Click the Export EZE8 button. The File Download dialog appears.
2 C(lick Save. The Save As dialog appears.
3 Enter, or browse to select, the location where you want to save report data. Click Save.

About the Bandwidth Usage report

The Bandwidth Usage report displays network bandwidth usage information.

Bandwidth Usage Interface - 1 o
%4 Flow Monitor i Repors v Alert Center 156.21.3.1 - Unnamed (351) M| Cptions  Help
Sort results by traffic direction: | Incoming 'l Date range: |La51 15 Minutes 'I Go
Bandwidth Usage by Group A8 E E
Mo data found

Bandwidth Usage by Host EES Nl
Host Imcoming Bytes Dutgoing Bytes Total Bytes
192.168.31.21 18548 MB 180.82 MB 366.30 MB
204.11.148.51 B9.54 MB 0 Bvtes 8854 MB
1921683163 565 MB 564 MB 11.28 MB
192.168.31.36 4,75 MB 4,74 MB 949 MB
192.168.31.47 3.33MB 3.20MB 6.53 MB

TPSWITCH I L ' Ipswitch WhatsUp Gold Preriurn Edition i 4.2 Bulld 239

The report consists of Flow Monitor workspace reports that summarize the incoming and
outgoing traffic for Flow Monitor groups and hosts.

= Bandwidth Usage by Group displays bandwidth usage summaries for each of your Flow
Monitor groups for the selected time period.

= Bandwidth Usage by Host displays bandwidth usage summaries for Flow hosts that are
using the most bandwidth during the selected time period.
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There are several ways you can refine this report.

= Select a different interface. Use the Interface list at the top of the page to select the
interface for which the report data displays.

= Sortresults by traffic direction. Use the Sort by traffic direction list at the top of the
page to select a direction for which the report data is displayed. Select Incoming,
Outgoing, or Total.

= Selecting a different date range. Use the Date range list at the top of the report to
change the timeframe for which report data is displayed. If you select Custom, you will be
prompted to enter a start and end time for the date range. For more information, see
Filtering by date and time (on page 49).

L‘Tj Note: Flow Monitor only displays data from one database at a time, and by default, displays
the most current data. If you select a time period that includes data stored in both the Flow
Monitor database and the Flow Monitor Archive database, a note displays below the date
range informing you that not all data is shown for the specified date range. For example, if
you select a date that includes 39 days of archived data, and one hour of current data, one
hour of current data is displayed in the report. You must modify the report's date to view the
archived data.

Configuring the workspace reports in this report

In addition to customizing the report data, there are several ways you can configure the
individual workspace reports within the Bandwidth Usage report.

= Configure the report. Use the configure button on a workspace report menu to change
the report configuration. For more information, see Configure Flow dialog.

= Expand and collapse workspace reports. Use the collapse and expand buttons on the
report toolbar to open and close the workspace reports within the report.

LT’j Note: Collapsing a workspace report does not remove it from the report. Instead, it collapses
the workspace report data and displays only the workspace report title bar.

Exporting, emailing, scheduling and managing reports

Use the Options E icon, at the top right of the page, to select and manage the following
options: Export reports, Email / Schedule Reports, or manage Scheduled Reports. For more
information see, Using Scheduled Reports in Flow Monitor: printing, exporting, and emailing
reports (on page 67).

Exporting individual workspace report data

Use the Export button on a workspace report's menu to export data to either a text file,
Microsoft Excel, or a PDF. For more information, see Exporting report data (on page 79).
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Selecting an interface

The Flow Monitor Interface Details, Interface Overview, and Bandwidth Usage reports display
data in context of a single interface on the source router or switch.

To change the interface for which data is reported:

1 From the toolbar at the top of the screen, click the Interface list. A list of all of the
available interfaces appears.

2 Select the interface for which you want to view the current report. The report refreshes
with data from the selected interface.

Filtering report data

You can filter the data in the Bandwidth Usage report two ways.

= Date and time (on page 61)

= Traffic direction (on page 62)

After you apply a filter, the report data refreshes to display data relevant to the applied filter.

Filtering by date and time

By default, the Bandwidth Usage report shows data for the previous fifteen minutes.

To change the time frame for which the Flow Monitor Interface Details report displays
data:

1 Atthe top of the report, select Date range. A list of common time periods appears.
2 Select one of the available time periods.
3 If you select Custom, the Start time and End time fields appear.

LT Note: Flow Monitor only displays data from one database at a time, and by default, displays
the most current data. If you select a time period that includes data stored in both the Flow
Monitor database and the Flow Monitor Archive database, a note displays below the date
range informing you that not all data is shown for the specified date range. For example, if
you select a date that includes 39 days of archived data, and one hour of current data, one
hour of current data is displayed in the report. You must modify the report's date to view the
archived data.

a) In Start time, select the date and time that corresponds with the beginning of the
time period for which you want to see data.

b) In End time, select the date and time that corresponds with the end of the time
period for which you want to see data.

4 Tip: You can also change the report date and time by using the Report Zoom Tool. For more
information, see About the Report Zoom Tool (on page 49).
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C1 Tip: Use the Standard Business Hours feature to setup reports designed for business hours
only. For more information, see Changing the report date range.

4 C(Click Go to apply the filter to the report. The report refreshes showing only data from
the time period selected.

Filtering by traffic direction

By default, the Bandwidth Usage report displays information about incoming traffic for the
selected interface.

To filter report data by traffic direction:

1 Atthe top of the report, select Traffic direction. A list of available traffic directions
appears.

2 Select a traffic direction.
= Inbound. Select this option to show only data that is being sent into the interface.

= Outbound. Select this option to show only data that is being sent from the interface.

3 After you select a traffic direction, the report refreshes. After it refreshes, the report
shows only data from traffic that matches your selection.
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About the Interface Usage report

The Interface Usage report gives a view of the total amount of incoming and outgoing traffic
for source interfaces over the selected time period. Interfaces can be displayed separately, or
grouped together by interface name. When you group together by interface name, all
interfaces under a single display name are added together, and all data displayed is a total for
those interfaces.

Interface Usage

%3 Flow Monitor \a Reports 1 Aler Center
Grovp by: [teface 7]
Date range: ’m‘ E
Choose Repor Columns I
Inferface Mame In Bytes In Average Speed | In Maximum Sp.. Out Bytes Ot Average Speed Out Maximurn Sp..| Total Byies =
(192 168.3.56) 1 74.96 KB 170 86 bps 631 67 bps 0 Bytes 0 bps 0 bps 7496 KB
(ATL-CISCO4505 ipewich.com)... 53.75 KB 12231 bps 138.27 bps 374 KB 133.67 bps 174.40 bps 112.49 KB
(atl-juniper2320) 125 89.78 KB 204 30 bps 371.33 bps BO57 KB 1683.35 bps 372.40 bps 170.35 KB
(ATL-CISCOM506 ipswilch.com)... 51.95 KB 118.22 bps 1.25 Kbps 387 KB 150,85 bps 3.26 Kbps 135.62 KB
(QA-2821 ipswitch corm) 1 115.02 MB 268 02 Kbps 308 53 Kbps 191 ME 4.45 Kbps 8.03 Kbps 116.93 MB
(dev-2821.ipswitch.com) 2 20.50 mMB 47.76 kbps 56355 Kbps 467 ME 10,89 Kbps 3213 Kbps 2517 B
(atl-juniper2320) ge-0M0UD.0 1533 MB 3571 kbps 41.42 Kbps E.55 ME 15.27 Kbps 19.66 Kbps 21.88 MB
(156.21.3.1) 350 17.54 MB 40.87 kbps 16717 Kbps 17.70 ME 41.25 Kbps 166.97 Kbps 35.24 WB
(dev-2821 ipswitch corm) 1 55.33 MB 128.93 Kbps 152 B2 Kbps 2050 MB 47.76 Kbps 5B3.99 Kbps 75.83 MB
(ATL-CISCOM508 ipswilch.com)... 55.95 MB 130.37 kbps 1.24 Mbps 53.18 MB 123.92 Kbps 1.24 Mbps 10913 MB
[ATL-CISCO4508 ipswitch.com) .. B0.01 MB 186.43 kKbps BEE.73 Kbps 57.02 MB 132.87 Kbps 27585 Kbps 137.03 MB
(ATLYDIP. ipswitch. com) B 101.35 MB 23616 kbps 450,05 Kbps 100.59 MB 234.39 Kbps 369.05 Kbps 201.94 MB T
[ATL-YOIP. ipswitch.com) Conn... 10857 WMB 252 99 Kbps 3BB.75 Kbps 101.44 MB 23538 Kbps 450.29 kKbps 210 MB
(342821 ipswitch com) 2 192 MB 4.48 Kbps 8.10 kbps 11502 MB 268.02 Kbps 306.59 Kbps 116.94 MB
[ATL-CISCO4508 ipswitch.com) .. 58.04 MB 135.24 Kbps 52609 Kbps 11883 M8 2V6.90 Kbps 1.69 Mbps 176.87 MB
(192.165.30 21 1.47 GB 352 Mbps 9.55 Mbps 266,10 MB B20.05 Kbps 217 Mbps 1.73GB
{cizcolB812 ipswitch com) Exter... 1.03 GB 246 Mbps 510 Mbps 44599 MB 1.04 Mbp= 163 Mbps 147 GB -

TPSWITCH
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The report displays the following usage data for each interface.

Interface Name the display name as configured by the user on the Flow Sources dialog
in combination with the interface identifier.

Incoming Bytes. Displays the number of incoming bytes for that interface or interface
name over the selected time period.

Incoming Average Speed. Displays the incoming rate in a multiple of bytes per second
for the interface over the selected time period.

Incoming 95th Percentile. Displays the results of the 95th percentile calculation for
incoming traffic during the selected time period.

Incoming Maximum Speed. Displays the maximum incoming rate in a multiple of bytes
per second achieved during the selected time period.

Outgoing Bytes. Displays the number of outgoing bytes for that interface or interface
name over the selected time period.

Outgoing Average Speed. Displays the outgoing rate in a multiple of bytes per second
for the interface over the selected time period.

Outgoing 95th Percentile. Displays the results of the 95th percentile calculation for
outgoing traffic during the selected time period.

Outgoing Maximum Speed. Displays the maximum outgoing rate in a multiple of bytes
per second achieved during the selected time period.

Total Bytes. Displays the total number of bytes for that interface or interface name over
the selected time period.

By default, the report displays data grouped by interfaces. You can refine the report in several
ways.

Grouping report data. Choose to Group by Interface or Interface Name.

Selecting a different date range. Use the Date range list at the top of the report to
change the timeframe for which report data is displayed. If you select Custom, you will be
prompted to enter a start and end time for the date range. For more information, see
Filtering by date and time (on page 49).
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About

the NBAR and CBQoS Reports

NBAR Report

Cisco Systems Network Based Application Recognition (NBAR) classification engine provides
a network device with the ability to recognize applications, including those that dynamically
assign TCP or UDP ports. The Top NBAR Applications report displays the top applications as
identified using Cisco's NBAR classification engine.

3

Application. Displays the application as identified by Cisco's NBAR classification engine.
Bytes. Displays the total number of bytes for the selected time period.

Throughput. Displays the number of bytes per second used by the application.

Usage. Displays the percentage of the total available bandwidth used by the application.

Percent of Top n. Displays the percentage ranking of the application within the top "n"
applications.

Note: The source device must be configured to generate NBAR information in order for this
report to generate data for the source device.

Note: For the Top NBAR Applications - Flow Details report, NBAR information generated
by the source device is gathered by Flow Monitor from flow data using Flexible NetFlow.

Note: For the Top NBAR Applications - Interface Totals report, the NBAR information is
gathered from the source device using SNMP polling. The Poll source for NBAR
information option is available on the Flow Source dialog.
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Class Based Quality of Service Report

The Class Based Quiality of Service (CBQoS) report provides information about the
effectiveness of class-based policies applied to an interface for all of the defined classes.

QoS Class Map. Displays the QoS class name as defined by the policy assigned to the
interface.

= Pre-Policy. Displays the amount of traffic for the class before the policy is applied.
= Post-Policy. Displays the amount of traffic for the class after the policy is applied.

= Dropped. Displays the number of bytes dropped as a result of applying the policy to the
class.

L’T Note: You must have defined QoS classes and policies on the source device before this
report is able to display results.

LT[B? Note: The CBQoS information generated by the source device must be gathered using SNMP
polling for CBQoS information.
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Using Scheduled Reports: printing, exporting, and
emailing reports

The Flow Monitor Log and Interface Usage reports can be printed and exported to a
formatted text file, Microsoft Excel, or a PDF. You can also email reports as a PDF, or send on
scheduled intervals. The Flow Monitor Interface Details, Interface Overview, and Bandwidth
Usage reports can be exported as PDF reports and emailed as scheduled reports. Click the

Options E icon, available at the top of each report, to manage these features. This option is
available to users with user rights for Manage Scheduled Report enabled. For more
information, see About user rights.

Interface Usage

% Flow Manitor & Repons b Adert Center
Group by | Interface -
Date range: m ﬂ
Choose Report Columns
Interface Mame In Bytes In Average Speed | In Maximum Sp...| Out Bytes Qut Average Speed | Out Maximum Sp..| Total Bytes A
(192.166.3.55) 1 9533 KB 216.93 bps 1.74 ¥hps 0 Bytes 0 bps 0 bps 9533 KB
[ATL-CISCO4506. ipswitch.com)... 37.02 KB B4.24 bps 9120 bps 4202 KB 95 63 bps 131.20 bps 79.04 KB
(athjuniper2320) 125 B4.10 KB 14587 bps 78553 bps B1.20 KB 139.25 bps 688 E0 bps 12530 KB
[ATL-CISCO4506 ipswitch.com)... 94.82 KB 215.76 bps 1.608 Kbps 23431 KB 53320 bps 519 Kbps 32913 KB
(Ca-2821 ipswitch, com) 1 13379 MB 311.74 Kbps 1.29 Mbps 229 MEB 5.33 Kbps 23.96 Kbps 13607 MB
[dew-2021 ipswilch. com) 2 579 ME 13.48 Kbps 34 76 Kbps JBE MB 9.00 Kbps 1367 Kbps 9.65 MB
(athjuniper2320) ge-0/0/0.0 1466 MB 34.16 Kbps 3063 kbps 577 MB 13.43 Kbps 16.84 Kbps 20.42 MB
[dew-2821 ipgwitch. cam) 1 555 MB 129,45 kbps 138.38 Kbps .79 MB 13.48 Kbps 34.78 Kbps 51.34 MB
(156.21.3.1) 350 2016 MB 46.98 Kbps 225 67 Kbps 20.35 MB 47 43 Kbps 226681 Kbps 4052 WB
[ATL-CISCO4806 ipswitch.com)... B3.68 MB 160.50 kbps 494 51 Kbps 56.08 ME 136,33 Kbps 261 B4 Kbps 126 96 MB
[ATL-CISCO4506 ipswitch.com)... B1.53 MB 14338 Kbps 1.24 Mbps 5818 MB 137 20 Kbps 1.23 Mbps 12072 MB
[ATL-VOIP ipswitch.com) & 130,36 MB 303.77 kbps 624.43 Kbps 126,98 MB 295 89 Kbps BB2.11 Kbps 257 34 MB
[ATL-VOIP ipswitch com) Conn,.. 13457 MB 31357 Kbps 593 45 Kbps 130,42 MB 30391 Kbps 624 56 Kbps 26455 MB
[Coa-2521 ipswitch.cam) 2 230 mMB 5.3 Kbps 2399 kbps 13379 MBE 31174 Kbps 1.29 Mbps 13608 MB
[ATL-CISCO4506 ipswitch com),,, 8962 MB 138.93 Kbps 454 B8 Kbps 139,50 MB 32505 Kbps 262 Mbps 19812 MB |
[ciscalB12ipswich.com) Exter.. 1.54 GB 367 Mbps 5.55 Mbps 557.92 MB 1.30 Mbps 1.59 Mbps 208 GB
[ATL-CISCO4506 ipswitch com)... 150 GB 4,52 Mbps 24 B1 Mbps 7E0.31 MB 1.62 Mbps 5.02 Mbps 266 GB
(156.21.3.1) 351 173GH 1,43 Mbps 18.51 Mbps 1.16 GB 282 Mbps 12,46 Mbps 291 GB
[ATL-CISCO4506 ipswitch com)... S04.71 MB 1.18 Mbps 2.47 Mbps 136 GB 3.25 Mbps 2332 Mbps 1.86 GB =

TPSWITCH L 3 C -- sold Premium Edilion v 4.2 Bu

© [igh Internet

@ Important: To use the print and export features, make sure client side JavaScript is enabled
in your browser's options.

“  Important: If the Secure Socket Layer (SSL) web server is enabled (WhatsUp Gold console -
Configure > Program Options > Web Server), make sure that you use a valid SSL certificate
in order for the PDF export feature to export files to a PDF format. To acquire a valid SSL
certificate, refer to an SSL certificate provider such as VeriSign. For more information, see
About the default SSL certificates.
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g Tip: In some cases, exported reports show more detailed data than the data displayed in the
report in the web interface. For example, an exported Excel report my contain more data
columns, or a floating data point with higher precision.

To print a report:
While viewing the report you want to print:

= Right-click anywhere inside the report window, then select Print.
-OR-
From the WhatsUp Gold web interface, click File > Print.

To export a report to a text file (full reports only):

While viewing the full report you want to export:

1 From the WhatsUp Gold web interface, on the Report Toolbar, click the Options E
icon. The Report Options list appears.

2 Select Export to Text.

3 Clear or select the following options: Include report title, Include column names to
either include or remove the report title or column names from the exported file.

4 Select a Column delimiter from the list.
5 Select a Text qualifier from the list.
6 Click OK to export the report to text.

To export a report to Microsoft Excel (full reports only):

While viewing the full report you want to export:

1 From the WhatsUp Gold web interface, on the Report Toolbar, click the Options E
icon. The Report Options list appears.

2 Select Export to Excel.

3 Clear or select the following options: Include report title, Include column names to
either include or remove the report title or column names from the exported file.

4 Select a Column delimiter from the list.
5 Select a Text qualifier from the list.
6 Click OKto export the report to Excel.

To export a report to a PDF:

While viewing the full report you want to export:

1 From the WhatsUp Gold web interface, on the Report Toolbar, click the Options E
icon. The Report Options list appears.

2 Select Export to PDF. The Export to PDF dialog appears.

68



Using WhatsUp Gold Flow Monitor

4
5

Select the following options:
Page size. Select from the list of page size options.

Auto size. Enable this option to, generally, make the best automatic adjustment to fit all
page content on the PDF.
Page orientation. Select Portrait or Landscape PDF.

Select the Live links option if you want to include clickable url links in the PDF report.
Click Export to export the report to a PDF.

To email a report as a PDF:

While viewing the full report you want to export:

1

2
3

4

From the WhatsUp Gold web interface, on the Report Toolbar, click the Options E
icon. The Report Options list appears.

Select Email PDF.

Enter the following information for the email: To, Subject, URL, select the PDF Options.
Refer to the dialog help for more information.

Click Send Email to send a PDF email immediately or click OK to complete the
scheduled email settings.

To send a full report as a scheduled report:

While viewing the full report you want to export:

1

From the WhatsUp Gold web interface, on the Report Toolbar, click the Options E
icon. The Report Options list appears.

Select Recurring Reports.

Enter the following information for the email: To, Subject, URL, select the PDF Options.
Refer to the dialog help for more information.

Click Test Email to send a PDF test email immediately or click OK to complete the
scheduled email settings.
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Understanding Flow Monitor workspace reports

Workspace reports are the individual small reports displayed in several of the Flow Monitor
reports and their views. Flow Monitor report views are user-customizable; they let you
organize various workspace reports by the type of information they display.

Flow Monitor workspace reports typically consist of a graph and a table of data related to the

graph.
Top Protocols 7% E E
TCP (B9.129%:)
ICKP (2.33%) LIDP (28.55%)
Protocol Bytes Percent of top 5
s 53.23 MB | 6912 %
ubpP 21.99 MB 25855 %
A 1.80 MB | 233%
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Workspace reports that display data from Flow Monitor can be used within Flow Monitor
report views and WhatsUp Gold workspace views.

LT? Note: While you can determine which workspace reports appear in workspace views in Flow
Monitor and WhatsUp Gold, Flow Monitor report views are more structured than WhatsUp
Gold workspace views. In WhatsUp Gold, you can position workspace reports anywhere
within a view; in Flow Monitor, report positions cannot be modified. As a rule, sender
workspace reports display on the left side of the report, while receiver workspace reports
display on the right side. Further, a page with no sender or receiver reports displays
workspace reports in one column.

Flow Monitor workspace report types

There are three types of Flow Monitor workspace reports.

= Interface Details workspace reports display summary information about specific details
of an interface; for example, applications, protocols, and types of service.

= Interface Troubleshooting workspace reports display data that would be useful in
troubleshooting bandwidth problems; for example, failed connections.

= Interface Traffic workspace reports display summary information about an interface's
incoming and outgoing traffic.

These types vary depending from where in the application you modify your report and
workspace views.
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If you add workspace reports to the Interface Details report in Flow Monitor, you see Interface
Details and Troubleshooting categories on the Configure Flow Interface Report dialog.

Workspace yiew name:
General
#  Interface Details
= Troubleshooting
i} e Top Senders with the Most Conversation Partners B 0 Top Receivers with the Most Conversation Partners

on Host is prohibited (0 24%)
iistratively Prohbited (1.09%)

ICMP Type

et Hnrassrhahia

(4] t/ Top Senders with the Most Failed Connections = 0 Top Receivers with More Failed Connections
1 4 ICMP Types 7 @ Packet Size Distribution
Preview:
ICMP Types AeE e =
Port Urreschabie (5200%) ——

—— Echo Reply (25.27%) E

Echo (21.40%)

Bytes Percentof top 5
—— o

[0k Concel ]

If you add workspace reports to a workspace view in WhatsUp Gold, you see Interface Details,

Interface Troubleshooting, and Interface Traffic on the Add Content To View dialog.

Report Name

= () Netflow
® () Interface Details
® ) Interface Traffic
@ (2] Interface Troubleshooting
1 NetFlow Source List
") @ NetFlow Database Size
[7) @ NetFlow Archive Database Size
@ () Performance - Historic
# () Performance - Last Poll
# () Ping Availability and Response Time
# () Problem Areas
# () Remote / Central

® (2 Spit Second Graphs
Preview:

NetFlow Sources

¥45192.168.3.46 - Atianta Data
W External . s
W intemal X
@ Null 0z

@212.37.2141 - Atianta Gateway Router
W intemal 0x
@ Local 0x

Out Traffic

1800 flows per minute
117.37Kops  NT3ER 736.35Kops
78975K0ps W N7 X 117.37 Kops
0.00 bps i 53% 5340 Kbps

0 flows per minute

0x 0.00 bps
0x 0.00 bps

(o owen ) |
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Navigating workspace reports

There are several ways to navigate Flow Monitor workspace reports.

= Workspace report menu (on page 73) gives you options to configure and access help for
each workspace report.

= Links (on page 73) allow you to apply any criteria shown in a report as a filter.

= Zoom control (on page 74) lets you change the amount of data shown in line graphs.

= Informational tooltips (on page 75) alert you to conditions which may warrant further
investigation.

Using the workspace report menu

Each workspace report has a menu on the right side of its title bar. Using the workspace
report menu, you can view help for the report, configure the report, export the report data, or
expand and collapse the report.

Workspace report menu buttons

|

il
(&=

=]

Click the Configure button to open the Configure dialog for the report.
Click the Export button to export report data.

Click the Help button to view the help for the report.

Click the Expand button to expand the report within the workspace view.

Click the Collapse button to collapse the report within the workspace view. Collapsing a
report does not remove it from the workspace view.

Using links in Flow Monitor workspace reports

Each Flow Monitor workspace report contains links that allow you to refine the data displayed
in the report. When you click on the data in the first column of one of the workspace report's
rows (or on a pie graph's wedges, or a bar graph's bars), the Flow Interface Details report
appears with the selected data applied as a filter.
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For example, as illustrated in the graphic below, if you click on ipswitch.com inthe Top
Sender Domains workspace report, the Flow Interface Details report appears with a Sender
Domain filter set to ipswitch.com.

Top Sender Domains AR 2

Unknowen (77 .52%

Interface: B Workspace View:

192.168.3.1 - Internal 3 |Z| Sl General
swikimedia.org (0.34% -
cachefiy net (0.45% utes [+ [ Go | [AddFilier| [Apply Filters]
fora.net (0.44% —
gpoe;;:czm ED.BS% | Sender Domain |Z| ipswitch.com @ |
hoingboing.net (0.59%
Iy Mgt (1.34% -
fastnet (0.86% Top Applicatig) EMa 3
e e Y S s« '.-ﬂ--—_;h* ."-—*.l.bl

newsgatar.com (2.41%

Sender Domain Bytes Percent of top 10

@ Unknown 99.78 MB  7782%
19.13MB H1492 %

‘3 newsgator.com 3.09 MB | 241%
by linw.net 172 MB | 1.34%
@ fastnet 111 MB | 0.86 %
google.com 1.06 MB | 0.83 %
[T] boingboing.net 772.23 KB | 0.59 %
[a] cachefiy.net 504.45 KB | 045%
@ perfora.net 577.28 KB | 044 %
@ wikimedia.org 447 13 KB | 0.34%

If you are viewing the Flow Interface Details report with a filter applied, clicking a linkin a
workspace report refreshes the report with the selected data applied as an additional filter
(the previously applied filters remain).

Using zoom controls on line graphs

Workspace reports that include line graphs, such as the Interface Traffic report, allow you to
adjust the window of time for which data is reported using the zoom controls. These controls
are located at the top center of the workspace report.

Interface Traffic AR
» GaEr) Zoom Controls
—
C 1500
# 1o

04
F0T e T2 pm

B g Bt
Zoom controls
[1] Page left Moves the graph time frame backward by 50% of the total time of the graph.

For example, if the graph shows data from 3:00 PM to 4:00 PM, clicking Page
left shifts the time frame of the graph to 2:30 PM to 3:30 PM.

74



Using WhatsUp Gold Flow Monitor

Zoomin Decreases the amount of time displayed in the report by 50%. For example, if
the report is displaying data for one hour, clicking the Zoom in button decrease
the display time to 30 minutes. The report must display at least 30 minutes. If
you attempt to zoom in on a report that shows 30 minutes, the report refreshes
but the time frame is not changed.

@ Zoom out Increases the amount of time displayed in the report. For example, if the report
is displaying data for 30 minutes, clicking the Zoom out button increases the
display time to 1 hour.

[+] Page right Moves the graph time frame forward by 50% of the total time of the graph. For
example, if the graph shows data from 3:00 PM to 4:00 PM, clicking Page right
shifts the time frame of the graph to 3:30 PM to 4:30 PM.

Using informational tooltips

In some reports, when Flow Monitor detects traffic patterns that may indicate a problem that
requires intervention, a yellow warning flag icon is displayed.

Inbound Interface Traffic FIEE

Intermal B (2 (99.63%)

Esternal (1) (0.27%%)
Local (07 (0.00%)

Interface Bytes Pachkats Flows Percent
External (1] ¥ 811.29 KB 14790 108 . 037%
Internal 6 (2] 211.32 MB 355166 28731 - 0963%
Local (0) 1.01KB 18 16 0 %

Position the mouse cursor over the yellow flag icon to view an information tooltip about the
specific issue, including links to related reports and specific help topics that may help resolve
the issue.

If you do not want to see information tooltips, you can disable them throughout Flow
Monitor. It is not possible to disable individual tooltips.
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To disable informational tooltips throughout Flow Monitor:

1

From any workspace view or report in the web interface, select GO. The GO menu
appears.

If the Flow Monitor section is not visible, click Flow Monitor. The Flow section of the GO
menu appears.

Select Configure > Flow Settings. The Flow Settings dialog appears.
Clear Enable information tooltips.
Click OK to save changes.

Configuring workspace reports

The process for configuring workspace reports varies depending on where in the application
the workspace report is viewed.

To configure a Flow Monitor workspace report in Flow Monitor:

1

In the title bar of the workspace report pane, click the Configure button & The
Configure Report dialog appears.

Enter or select the appropriate information in the following fields.

Report name. Enter a title for the workspace report. This name appears in the title bar of
the workspace report's pane.

Maximum rows to return. Enter the number of records you would like displayed in the
workspace report.

Display. Select the type of data you would like displayed within the workspace report
(Chart and data, Data only, Chart only).

Chart type. Select the type of chart you would like the report to display.
Width. Specify how wide, in pixels, the graph or chart should appear.
Height. Specify how tall, in pixels, the graph or chart should appear.

Time graph scale. Select the transfer speed format for which you want to view data.
Choose Auto scale, bps, Kbps, Mbps, or Gbps.

= Minimum value. Enter a minimum value for the graph.

= Maximum value. Enter a maximum value for the graph.
Click OK to save changes.
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To configure a Flow Monitor workspace report in WhatsUp Gold:

1 Inthetitle bar of the workspace report pane, click Menu > Configure. The Configure
Report dialog appears.

2 Enter or select the appropriate information in the following fields.

= Report name. Enter a title for the workspace report. This name appears in the title bar of
the workspace report's pane.

= Date range. Select the timeframe for the traffic about which you want to see a report.
You can select either the last 5, 15, or 30 minutes, or the last hour.

= Interface. Select the router interface that is used by the traffic you want to see in this
report.

= Interface traffic direction. Select a direction for which the report will display data for the
selected interface (In, Out, or Both).

= Maximum rows to return. Enter the number of records you would like displayed in the
workspace report.

= Display. Select the type of data you would like displayed within the workspace report
(Chart and data, Data only, Chart only).

= Chart type. Select the type of chart you would like the report to display.
= Width. Specify how wide, in pixels, the graph or chart should appear.
= Height. Specify how tall, in pixels, the graph or chart should appear.

= Filter. Click this button to apply a filter to the workspace report. If a filter is applied, only
data that meets the filter criteria is displayed in the workspace report. After clicking, filter
fields appear below the button.

Select the type of filter you want to apply. If appropriate, select a secondary filter type
from the second filter field. For more information on filters, see Filtering Flow Monitor
workspace reports in WhatsUp Gold (on page 78).

'LT? Note: Filters applied here are listed at the top of the workspace report in Current filters.

3 Click OK to save changes.
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Filtering Flow Monitor workspace reports in WhatsUp Gold

You can apply filters to many Flow Monitor workspace reports in WhatsUp Gold using the
workspace report configuration dialog.

& Configure NetFlow Report (|
Report name:
NetFlow - Top Senders
Date rapge:
Last 30 Minutes -

Interface:
192.168.3.27 - Internal 3 -
Interface traffic direction:

Inbound and Outbound -

Maximum rows to return:
5

Display:

Chart and data -
Chart type:

Pie chart (transparent 3D) -
Width: Height:

500 200

[ AddFilter |

Receiver - £ Ramal

Filtering is essentially drilling down to find more detailed information in a workspace report.
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Workspace reports available for filtering in WhatsUp Gold:

=  Top Senders

=  Top Receivers

=  Top Protocols

= Top Types of Service

= Top Applications

= Top Sender Domains
= Top Receiver Domains
= Top Sender Countries
= Top Receiver Countries
=  Top Sender Groups

=  Top Receiver Groups

=  Top Sender TLD

= Top Receiver TLD

= |CMP Types

m  Packet Size Distribution

Applied filters are listed in Current Filter.

Exporting workspace report data

Exporting report data

You can export data displayed in workspace reports by clicking the Export 2 button on the
workspace report menu.

'LTF Note: Flow Monitor data is exported according to the parameters set in the Flow Data Export
Settings (on page 80) dialog.

To export report data:

1 Click the Export 2 button. The File Download dialog appears.

2 C(lick Save. The Save As dialog appears.

3 Enter, or browse to select, the location where you want to save report data. Click Save.
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Configuring export settings

Use the Flow Export Settings dialog to configure the parameters for exporting report data.
Each time you export Flow Monitor data, it will use the parameters set in this dialog. You can
export data to a text file, Microsoft Excel, or a .PDF.

To configure the Flow Monitor export settings:

1

From any workspace view or report in the web interface, select GO. The GO menu
appears.

If the Flow Monitor section is not visible, click Flow Monitor. The Flow section of the GO
menu appears.

Select Configure > Flow Data Export Settings. The Flow Export Settings dialog
appears.

Select the desired options.

Select Export to Text to export Flow Monitor data to text.

Select Export to Excel to export Flow Monitor data to Microsoft Excel.

Select Export to PDF to export data to .PDF.

Select Include report title to include the report name in the exported data.
Select Include column names to include the column titles in the exported data.

Select Include graphs to include graph(s) with the exported data (available on select
reports).

Select the Text options:

= Column delimiter. Select the character type you want to use to separate fields for
each set of data when reports are exported. The delimiter options are: Comma,
Semicolon, Tab, or Vertical Bar.

= Text qualifier. Select the quote type you want to use to separate field data from
column delimiters. The text qualifier options are: Double Quote, Single Quote, or
None.

Click OK to save changes.
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Linking to Flow Monitor reports from WhatsUp Gold
workspace reports

There are several ways to connect to Flow Monitor reports from WhatsUp Gold.

Linking to the Interface Details report from workspace reports in
WhatsUp Gold
The Interface Details workspace reports in WhatsUp Gold link to the Interface Details report in

Flow Monitor. The Interface Details workspace reports can be found on the WhatsUp Gold
workspace report picker under Flow Monitor.

& Add Content To View | 5= |
Report Hame Report Type
= (] Flow Monitor
= Interface Details

1 @ Top Protocols Home

& Top Apglications Home

& Top Senders Home

7| L Top Receivers Home

& Top Sender Domains Home

& Top Recenver Domains Home

& Top Sender Countries Home

& Top Receiver Countries Home

& Top Sender Groups Home

& Top Recenver Groups Home

& Too Sender TLD Home

Preview

sh_mp=witch com (56.83%)
LEX-TY (14.95%)

ATL-QAZKE-BAbL (12.83%)

feh_m jpswich.com (5.19%) sli-memith pswich_mipsai

OK | cancel |
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To link to the Interface Details report from an Interface Details workspace report:

Flow Monitor - Top Applications

| Interface: 192.168.3.9 - External : Inbound and Dutbound |

hittp (21 46%)

imcromedia-fos (30 27%)

Metflones [9.31%)

Sender lication
{?}macnmnedhdts
@ hitp

& Unclassified traffic
9 Hetflow

£03 Netflow

= (Click the interface name at the top of the workspace report. The Interface Details report
for the selected interface appears.

_Or_

Port
1935

B0

09089
0996

Bytes

236,46 MB
167 .62 MB
167.04 MB
137.35MB

T2TINB

Menu

Unclazzified tratfic (21.3

Netflow (17 58%:)

Percent of top 5

8D 27 %
P46 %
2138 %
M1758 %
l931%

= Click an entry in the far left column of the workspace report. The Interface Details report

for the selected interface appears. The entry that you click is applied to the report as a

keyword filter.

_Or-

= (Clickin the workspace report's graph area. The Interface Details report for the selected

interface appears.

m Note: Any applied filters carry over to the Interface Details report.
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Linking to the Interface Overview report from workspace reports in
WhatsUp Gold
Interface Traffic workspace reports in WhatsUp Gold link to the Interface Overview report in

Flow Monitor. Interface Traffic workspace reports can be found on the WhatsUp Gold
workspace report picker under Flow Monitor.

& Add Content To View e
Report Name Report Type
# (1 Interface Details ]
| gl Interface Traffic Home
@ Inbound Interface Traffic Home
& Outbound Intedace Traffic Home
il Inbound Interface Utilization Home
) Outbound Interace Utilzation Home
# ] Interface Troubleshoaoting
1 Netflow Source List Home
& Netfiow Database Size Homa
@ Hetlow Aschive Database Size Home

# (] Performance - Historic

# [ Performance - Last Poll
Preview

g i

Jan 29, 2008 dan 31, 2008 Feb 02,
Tue 1:00 pm Thu 1:00 pesy Sat 1

Ok Cancel

To link to the Interface Overview report from an Interface Traffic workspace report, click the
interface name at the top the workspace report. The Interface Overview report for that
interface appears.
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Finding more information and updates

Following are information resources for WhatsUp Gold. This information may be periodically

updated and available on the WhatsUp Gold web site
(http://www.whatsupgold.com/wugtechsupport).

= WhatsUp Gold Release Notes. The release notes provide an overview of changes, known

issues, and bug fixes for the current release. The notes also contain instructions for
installing, upgrading, and configuring WhatsUp Gold. The release notes are available at
Start > Programs > Ipswitch WhatsUp Gold > Release Notes or on the WhatsUp Gold

web site (http://www.whatsupgold.com/wug143relnotes).

= Application Help for the console and web interface. The console and web help contain

dialog assistance, general configuration information, and how-to's that explain how to
use the features. The Table of Contents is organized by functional area, and can be

accessed from the main menu or by clicking Help in the console, or the ? icon in the web

interface.

= WhatsUp Gold Getting Started Guide. This guide provides an overview of WhatsUp

Gold, information to help you get started using the application, the system requirements,
and information about installing and upgrading. The Getting Started Guide is available on

the WhatsUp Gold web site (http://www.whatsupgold.com/wug143gsq).

= WhatsUp Gold User Guide. This guide describes how to use the application out-of-the-

box. It is also useful if you want to read about the application before installing. To view

the online User Guide, see the WhatsUp Gold web site
(http://www.whatsupgold.com/wug124oh).

= Additional WhatsUp Gold resources. For a listing of current and previous guides and

help available for WhatsUp Gold products, see the WhatsUp Gold web site
(http://www.whatsupgold.com/support/guides.aspx).

= WhatsUp Gold optional plug-ins. You can extend the core features of WhatsUp Gold by
installing plug-ins. For information on available plug-ins and to see release notes for each

plug-in, see WhatsUp Gold plug-ins documentation
(http://www.whatsupgold.com/support/guides.aspx).

= Licensing Information. Licensing and support information is available on the Mylpswitch
licensing portal (http://www.myipswitch.com/). The web portal provides enhanced web-

based capabilities to view and manage Ipswitch product licenses.

= Technical Support. Use the WhatsUp Gold Support Site for a variety of WhatsUp Gold
product help resources. From here you can view product documentation, search
Knowledge Base articles, access the community site for help from other users, and get
other Technical Support information. The Support Site is available on the WhatsUp Gold

web site (http://www.whatsupgold.com/wugtechsupport).
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